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1 About Outpost
1.1

What is Outpost?
Outpost is a PC‐based messaging client that lets you to exchange your packet
messages with almost any Amateur Radio Bulletin Board System (BBS).
Using your existing Terminal Node Controller (TNC) or AGWPE‐enabled sound‐card,
radio, and a Windows‐based PC, all you need to know is your call sign, information
about your TNC, and information about the BBS. Once the program is configured,
Outpost then manages all message‐handling between your PC and the BBS.
Outpost also lets you send, receive, read, delete, create, reply to, or forward
messages back to the BBS.
Unlike commercial mail systems, BBS‐based mail is transmitted unencrypted over
the amateur radio bands. There is nothing private about it.

1.2

Why Outpost?
Outpost was created to support the packet communication needs of an ARES,
RACES, or other emergency communications response team during a disaster or
other activation where Amateur Radio is deployed.
During an emergency, you may be required to pass lists of information or detailed
instructions within an Operational Area to support Logistics, Operations, or
Planning/Intel activities as required by a municipality’s Emergency Operations
Center (EOC). Packet is ideal for this task. Outpost makes the job even easier by
automating the manual interaction between you and the BBS.
Because Outpost leverages the existing packet infrastructure, it can be deployed
relatively easily and quickly. Outpost can either operate as a single stand‐alone
messaging client, or collaboratively with other Outpost stations using built‐in
features that enhance overall message handling effectiveness.
If Outpost had a tag line, it would be: “Focus on the message, not the medium.”
An emergency activation is not the time to think about packet training. By using an
application with a look and feel similar to contemporary email clients, Outpost
helps emergency communicators get a packet message written and transmitted
quickly without all operators needing to be packet experts.
A successful Outpost deployment does require a few things:


At least one individual who has a fundamental understanding of packet, and
can configure and verify that Outpost is operational prior to a response.



A definition of your emergency response team’s operating policies for packet
messaging. Operating policies are the guidelines that would be observed
during an activation.
Examples of a policy would be things like (i) no keyboard‐to‐keyboard
communications will be used, (ii) polling the Operational BBS will occur no
more frequently than every 15 minutes, (iii) tactical call signs will be used, etc.
Most packet messaging policies can be implemented through Outpost.

April 9, 2020
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1.3

A typical TNC Session today
Before Outpost, if you wanted to send and receive a packet message, you needed
a terminal emulator program and be familiar with the commands for controlling
your TNC and a remote BBS. For instance, you probably did something like this:

Figure 1: Sample TNC session using Hyperterm
1.

Turn on your Computer and run your terminal emulator. You may be using
PACTERM or some other TNC program. I’ve used the general‐purpose MS‐
Windows HYPERTERM program because of its ability to cut‐and‐paste text
to and from it.

2.

Turn on your TNC. Verify you see the TNC welcome message.

3.

Turn on your radio and select the frequency on which the BBS operates.

4.

Check the configuration of the TNC. This could include sending the MY
command to review or change the TNC’s call sign, setting the date and
time, or changing any display settings with the ECHO or AUTOLF
commands.

5.

Connect to the BBS. After issuing the Connect <call sign> command, you
verify the BBS responds with its welcome message.

6.

Once connected, you check for messages addressed to you with the LM
(list mine) command. If you operate NTS packet, you may check for any
NTS messages with the LT (list traffic) command. Then, you may read
them with the Read <####> command (where #### is the message
number) and delete them off the BBS with the Kill <####> command.

7.

You may also check out current bulletins with the LB (list bulletins)
command, and then read them one by one.

8.

If you wanted to send a private message to a friend, you would enter the
SP <call sign> command (send private). When prompted, you enter the
subject, and then the message.

NOTE: As a reminder, every time you press Enter on your keyboard, the line of text
you just typed is sent to the TNC and transmitted to the BBS. The only way to
correct an error in your message is to finish your message, delete it from the
BBS, and start over.
9.

April 9, 2020

When done, you exit the BBS with the B or Bye command.
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10. Because you don’t know when the other person would get the message,
you would repeat steps #5, #6, and #9 to see if you have a reply.
During normal operation, the above steps can get tedious, in particular if you are
expecting a reply.
During an emergency, you may have an established routine to do something
similar, with more purpose and intent to the steps outlined above.

1.4

A Typical Outpost Session
Outpost takes care of a lot of the above steps. Once configured, Outpost takes on
the job of sending and processing all TNC and BBS commands during a “Send/
Receive Session.” Because you have previously told Outpost what the TNC and BBS
prompts and commands are, Outpost automatically sends, waits, receives, and
processes all exchanges with the BBS.

Figure 2: Outpost’s Main window
Here is what you would do with Outpost:

April 9, 2020

1.

Turn on your Computer and run Outpost.

2.

Turn on your TNC.

3.

Turn on your radio and select the frequency.

4.

Confirm that Outpost has the correct TNC and BBS selected.

5.

From Outpost, press the Send/Receive button.

6.

Outpost will automatically:
▪

Send the appropriate TNC commands to get it ready for a
Send/Receive Session.

▪

Connect to the BBS by sending the Connect <bbs> command.

▪

Check to see if you have any private messages in the Outpost Out Tray
to be sent to this BBS. If so, it will send them with the SP Command.
It then does the same for any NTS or Bulletins you may want to send.

▪

Check for messages addressed to you with the LM command. Outpost
will read these messages with the R <####> command, then delete
them off the BBS with the K <####> command. Outpost will also
check for and retrieve NTS and bulletins if selected.

▪

Finally log off the BBS with the Bye command.
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▪

If configured, Outpost will repeat this cycle on a regular interval as
defined by you.

In short, Outpost automates the Packet Session by sending TNC and BBS
commands, looking for prompts, and responding with the next appropriate
command.
Whatever you manually type at the keyboard into your terminal emulator
program, Outpost does this for you automatically.

1.5

Outpost Features
Message Management
1.

Multiple message folders. Outpost lets the user manage messages in a
series of standard and custom folders.

2.

Message Types. Outpost supports three primary message types: Private,
NTS, and Bulletins. Sent and received messages are displayed with their
appropriate types indicated.

3.

Address book. The user can create entries for a single user or for a
distribution list.

4.

Profiles. You can have different configurations of settings that can be
quickly loaded to match your operational situation – casual, emergency,
etc.

5.

Message Creation. Outpost allows messages to be created from scratch,
importing text from an ASCII file, cut and pasted in from other applications,
by Replying to or Forwarding a previously received message, or by a user
defined message add‐on.

6.

Text Message Formatting. Messages can be entered in a free‐form text
area. Simple formatting can be performed, errors corrected, and text can
be added or deleted prior to sending the message.

7.

NTS Message Maker. Outpost also helps format NTS messages. The NTS
Message Maker is a fill‐in‐the‐blanks form that prompts for all required
fields needed to create a correctly formatted NTS packet message. ARL
Messages can also be added and automatically formatted.

8.

Report Interpreter. Outpost supports an online report interpreter that
helps get a pre‐defined report filled in and formatted quickly.

9.

Message archiving. After an emergency, the entire message database can
be archived to either an Outpost‐readable format for importing later on, or
a user‐readable format.

10. Scripting. Outpost provides a scripting language that gives you a lot of
flexibility for automatically managing your message environment.

April 9, 2020
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Packet Session Management
11. Serial Comm Port Management. Outpost supports direct serial
communications with a TNC by setting up the serial port and handling any
contention for the port that may exist.
12. AGWPE Support. Outpost supports the AGWPE application located either
locally on the same PC as Outpost, or somewhere else on the network.
13. Telnet Support. Outpost supports Telnet access to a network‐accessible
BBS.
14. Interface Management. Outpost sends all initialization commands to the
TNC, AGWPE, and Telnet interface to prepare it for a Packet Session.
15. BBS Management. Outpost sends the right BBS commands at the right
time.

Figure 3: Outpost’s New Message window
16. Support for several popular BBSs and PBBSs, including:
•
•
•
•
•
•
•
•
•
•
•
•
•
•

KPC2, KPC2400, KPC3+, KC9612, KAM (all models), Data Engine
PK‐88, PK‐96, PK‐232, DSP‐232
MFJ‐1270x, MFJ‐1278
AA4RE
BPQMailChat
DXNET
F6FBB
HAMSERV
JNOS, SNOS, TNOS
MSYS
OpenBCM
N0ARY
Winlink’s RMS and CMS
W0RLI

Configurations and Setups
17. Interface configuration setup
18. TNC configuration setup. Outpost manages a list of Interfaces, TNCs and
their commands. TNCs can be added or deleted.

April 9, 2020
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19. BBS configuration setup. Outpost will manage a list of BBS’s and their
commands. BBSs can be added or deleted. TNCs can be linked to a BBS
entry for quick BBS selection.
20. Message retrieval. Outpost allows the user to choose which types of
messages will be checked for and retrieved from the BBS. The three
message types are: Private, NTS, and Bulletin.
21. Retrieval Automation. You can configure Outpost to run a Send/Receive
Session automatically at a specific time interval set (in minutes).
22. Station Identification. The Station ID (Call Sign) can be changed.

1.6

The Outpost operating environment
Outpost can operate in a number of packet environments where one or more BBSs
are used as message drops (a typical star network). For instance, Outpost may be
operating in a network along with other Outpost users or other terminal emulator
program users with a system running BBS software. In Santa Clara County, W6XSC‐
1 is the county’s packet BBS system serving several San Francisco South Bay Area
city EOCs.

Figure 4: Central BBS Station serving many Packet users
Outpost could also be operating in a smaller closed packet network where one
user has enabled a TNC’s Personal BBS (PBBS) feature thereby providing a low cost
central message drop for several stations.

1.7

What Outpost does not do

April 9, 2020

•

Outpost does not support any of the bulletin board forwarding protocols (because it
is a client, not a server). Instead, it automates sending commands and interprets
the returning prompts of both the TNC and the BBS to manage message handling.

•

Outpost does not support any of common email protocols such as POP3 or SMTP.
However, text‐based internet mail is available through Winlink’s RMS and CMS
nodes, or JNOS when configured to do so.
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2 Installation
2.1

System requirements
Outpost has been verified to run under the following operating system
environments:
• Microsoft Windows 98, NT, 2000, ME, XP, Vista, Windows 7, 8, and 10.
• Linux that is also running WINE version 1.6.4 or later.

2.2

Hardware requirements
MS‐Windows requires the following hardware:
• Intel‐based PC required to support any of the above MS Window Operating
Systems
• Open Serial Port for Serial or AGWPE interfacing, or
• USB port with a serial adaptor to connect to the TNC
• Network interface for remote AGWPE or Telnet interfacing

2.3

Download from an Internet
Installing the software off the Web begins by downloading the Outpost Install
Program to your PC.

2.4

1.

Go to the website (www.outpostpm.org), navigate to the Downloads section,
and look for Outpost v3.3 Installation.

2.

Click on the link to download the installer. Or right click on the link, and select
“Save Target As”. The install program is named opsetup320cxxx.exe, where
“xxx” is the current installation version.

Outpost v3.3 installation
The Outpost 3.3 installation program comes with all files needed to install Outpost
on your PC. After downloading the install program from the Outpost website, run
the program. Here are the install steps that are presented.
1.

Click on the opsetup320cxxx.exe program to start the installation process.

2. Information. This is general information that you should check out depending
on the type if install you want to perform. When done, press Next > to
continue.

3. Select Destination Location. This is where the Outpost Programs will be
installed. Unless you really want to install Outpost somewhere else, just press
Next > to continue.
4. Select a Data Location. This is the location where Outpost data will be
installed. You can change this if you want your Outpost data in a different
directory, or possibly on a USB Memory Stick. Unless you really want to install
Outpost data somewhere else, just press Next > to continue.
5. Select components. Outpost can install program components in the following
configurations:
a.

April 9, 2020

Update for Existing users: Installs only the Program Files. You may
also want to check the User Documents component to get the latest
user guides for this release.
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b.

First time installation for new users: Installs all components;
programs, documentation, config files, samples, etc. You can
uncheck specific components as necessary.

c.

Custom Installation: This option lets you pick whatever components
you want to install.

Choose which ever installation option is right for you, then press Next >.
6. Select Start Menu Folder: The location where the install program will place the
program short‐cuts. Take the default location offered unless you want to pick
someplace else.
7. Select Additional Tasks: The only task available is creating icons on the desk
top. This is purely your option, but most people select it anyway.
8. Ready To Install: all choices are made, and this is a summary of the options you
selected. Press Install to continue with the install process.
9. Finally… you can view the README.TXT file.
10. When done, run Outpost as usual.

2.5

Operating System Considerations
Outpost has the capability of independent operation where it will periodically poll
the BBS for any new incoming message traffic. Because of this feature, the PC can
run unattended.
However, the absence of any user interaction may cause the PC to think that it is
idle and invoke any enabled power management features such as “Turn off Hard
Disks,” “System Standby,” etc.
If you intend to run Outpost unattended, set these features to NEVER or OFF.
These properties should be accessible from the Control Panel.
Additionally, depending on your hardware, specific BIOS setting changes may also
have to be made.

Sample Power Option Setup Menus on a Windows XP and Windows 10

April 9, 2020
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3 Getting started
Outpost manages and controls all aspects of the message “send and receive”
process. This section describes how to use Outpost.

3.1

Station Identification
When you start Outpost, you are presented with the Station Identification window
that displays the last selected Profile (see Section 6 Setting up Profiles), the Legal
Station Call Sign and name of the Call Sign owner that was entered the last time
Outpost was run.
If this information is still correct, then press OK to continue. If the operator’s legal
call sign and name are different from what is listed, then use to pull down box to
find your call sign, or press New to create a new entry. Press OK when done.

The fields below the Legal Name section are the Tactical Call fields. See
Section 11 Using Tactical Calls for details on how to set up und use Tactical Calls.

April 9, 2020
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3.2

The Main Outpost Form
From the main Outpost form, you can manage your messages, perform application
setups, and control your Send/Receive Sessions.
This form has one view that allows the user to review messages stored in several
different folders. The form is divided into four primary areas:

Figure 5: Main Outpost Window
1.

Menus and Toolbars – This portion of the main form controls the operation and
execution of all program tasks. We will step through several of them as we review
specific areas of the application.
NOTE: Some of the more common menu items are also implemented as Tool Bar
buttons. See the associated menu item below for the description.
Menus
File

Description
New Message: Opens a new message window for
creating a message.
Save As: Saves the highlighted message to an ASCII text
file.
Save As, No Headers: Saves the body of the highlighted
message to an ASCII text file without the message headers
(From, To, Date, Subject).
Save All: Saves all the messages in the current folder to a
single ASCII text file. Messages are separated by a header
line and a Form Feed character, thereby allowing this file
to be sent directly to a printer for bulk printing.
______________________________________________
Export: Writes the message database to a “*.oaf”
(Outpost Archive) file. This file can be later used for
importing messages back into Outpost.
A submenu lets the user to select messages from either
All Folders, export all folders.
This Folder, export the currently selected folder.

April 9, 2020
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Menus

Description
Import: Reads the file created by the Export function.
Messages are loaded back in the same folder from which
they originated.
Delete all Messages: Deletes all messages in all folders.
This function can be performed any time, but probably
after performing a full or partial export of messages to an
archive file. When selected, the user will be prompted
whether they want to continue.
WARNING! If you are unsure, you should Export all
messages before invoking this function.
______________________________________________
Change Folder: displays a sub‐menu of all the 6 basic
folders. Clicking on a folder name will display messages
stored in that folder. These folders are:
 In Tray
 Out Tray
 Sent Msgs
 Archive
 Draft Msgs
 Deleted Msgs
______________________________________________
Print. Allows the user to select a printer, then print the
currently highlighted message to the printer.
Print, No Headers. Same as Print above, but no message
header (BBS, From, To, Subject, Date) is printed.
Print Setup. Allows the user to select a default printer for
Outpost.
______________________________________________
Most Recently Used List. As BBS/TNCs combinations are
executed, a BBS | TNC entry is displayed here. When
double‐clicking on an entry, the BBS and TNC entry are
loaded together. The default number of entries displayed
is 4. To change this setting, see the Tools > General
Setting menu.
______________________________________________
Exit: Exits the program.

Edit

Delete. Deletes the highlighted message from the current
folder. If the selected folder is the “Deleted Msgs” folder,
then the user is prompted to confirm the delete request,
and then the message is permanently deleted.
Move to Folder. Moves the highlighted message to other
folder specified by the sub‐menu choice.
Copy to Folder. Makes a copy of the highlighted message
to other folder specified by the sub‐menu choice.

April 9, 2020
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Menus
Setup

Description
BBS. Manages the list of available BBSs. Users can select
or update an existing BBS, or create a new BBS entry by
entering a BBS friendly name, connect name, prompts and
commands.
Interface. Manages the different interface methods –
TNCs, AGWPE, and Telnet. Users can select or update an
existing interface and its associated parameters, or create
a new interface by entering the TNC prompts and
commands.
See Section 4 Setting up Interfaces for more information.
See Section 5 Setting up a BBS for more information.
Station ID. Allows the user to change the legal call sign
that Outpost uses, the user name, and to optionally select
a Tactical Call to be used for logging on to the BBS.
See Section 11 Using Tactical Calls for more information.
The second tab on this form is also the place to define
telnet logons and passwords, and manage the Winlink
Secure Logon password. The 3rd tab supports adding a
message signature to your message.
Address Book. Manages a list of user defined address
entries. Addresses can either be a single address for a
user name (i.e.: Name is JIMOB, address is KN6PE), or a
list of addresses as a Distribution List.
See Section 9 Using the Address Book for more
information.
Profiles. Profiles are a collection of configuration settings
that can be loaded with a single selection. This setup
option lets you create and delete new profiles.
PC Time Check. Opens a tool that reports on, and lets the
user update, the PC date and time. This can also be set to
automatically open this tool when Outpost starts from
the Tools > General Settings form. This is useful for PCs
that tend to get out of time synch and potentially lead to
incorrect message time stamping.

Tools

Send/Receive Settings. Sets various parameters to
control each Send/Receive Session, including:


Automation. Selects one of the 4 methods for
scheduling Packet Sessions.



Receiving. Selects what Outpost will do after a
message is received.



Other controls that control printing and Alerts.

See Section 10 Customizing the Send/Receive Session for
more information.
Message Settings. Sets various conditions to control how
messages are handled, including:


April 9, 2020
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Menus

Description
auto‐message numbering, and signatures.


Replies and Forwards.



Requesting Delivery or Read Receipts.



Message deletes and external program message
handling (such as PacFORMS, ICS213)

See Section 8, Customizing Message Settings for a full
description.
Report Settings. Allows the user to set up report values
by Online Reports, ICS309, and NTS message creation, as
well as configure specific on‐line reports to be loaded with
a single F‐key stroke.
Log Settings. Sets up different log options used for
debugging TNC or BBS problems when they occur.
General Settings. Minor options for program control.
Script Settings. Defines the names of the scripts to be run
at the start of an Outpost Session or on Outpost exit.
Scripts. Presents 2 submenus that allow you to run the
scripting tool or pick and run a predefined script.
See the Outpost Scripting Users Guide for details.
______________________________________________
Packet Session Counter Reset. The session counter is
displayed in the Packet Session Log. This command resets
the counter back to zero.
______________________________________________
Empty “Deleted Items” Folder. Deletes all messages in
the “Deleted Items” Folder. Once deleted from here, they
are gone for good.
______________________________________________
Reset Column Widths. Restores the Message List Display
columns to a default size. This option is great for
redisplaying previously hidden (or lost) columns.
Pack Column Widths. Forces the Message List Display
column widths to align to the max size of the column
content.
Reset form to normal: Occasionally, the form gets stuck
in either a minimized state or a maximized state, and
cannot be restored to a movable window. This button
resets the form to the default setting.
______________________________________________
Interactive Packet. Brings up a terminal emulator that
gives you interactive packet access to your TNC or BBS
(outside of a Packet Session) by either a Serial Port device
(TNC), AGWPE, or Telnet.
Forms

April 9, 2020
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Menus

Description
transaction history from Outpost and presents a series of
reporting options for the user to create an ICS 309
Communications Log for packet messaging.
See the ICS 309 Communications Log Builder Users Guide
for details.
______________________________________________
Add‐on Forms. Outpost reads the Launch.ini file located
in the data directory and loads the available form or
program names for scheduling from Outpost.
Outpost will check if the form file exists, and if it cannot
find it, the entry will be loaded, but disabled (grayed out).
______________________________________________
ICS 213 Message Form. Runs the ICS 213 Message Maker.
The Ics213mm.exe program presents a standard ICS 213
message form.
See the ICS 213 Message Maker Users Guide for details.

Actions

Send only. Initiates a Packet Session for sending any
messages in the Out Tray. No BBS message checking is
made.
Send/Receive. Initiates a Packet Session with the
selected BBS.
______________________________________________
New Message. Opens a new message window for
creating a message.
Open a Message. Opens the currently highlighted
message in the message list.
Open enhanced Msg in Client. This option will cause
Addon messages to be opened in their native program.
Open enhanced Msg as Text. This option will cause
Addon messages to be opened in the Outpost message
form regardless of the Addon setting.
______________________________________________
Force Bulletin Retrieval, one time. When checking this
option, if Retrieve Bulletins is checked, Outpost will
retrieve all bulletins selected for retrieval regardless of
whether they were previously retrieved.
______________________________________________
View Outpost Data Directories. Opens Windows Explorer
to the location where Outpost data files and data file
subdirectories are located.
______________________________________________
On‐line Report Definition #[1‐4]. The name of a
predefined report that was set up in Tools > Report
Settings menu. Pressing the associated F‐Key loads the
report into a message form.

April 9, 2020
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Menus

Description

Help

My IP Address. Displays the network IP address and host
name for this PC. This is useful when setting up
ICs213mm.
About Outpost. Description of this program; includes the
License and Terms of Use.

2.

Profile

Shows the current Profile selected. It also allows the user
to select a different previously configured profile from the
dropdown menu.

AA

Two buttons, decreases (smaller A) or increases (larger A)
the font size of the message list. Once you make a
change, restart Outpost to make it apply to all items.

Folders and Shortcuts – Outpost organizes messages in a series of folders. Once a
folder is selected, the contents of that folder are displayed and the selected folder
name is shown above the message list area. The first 6 folders support the
program’s message workflow. We’ll talk about that in a later section.
Folders
In Tray

Description
Messages retrieved by Outpost from the BBS are placed in
the In Tray. The Date/Time field is set to the time that the
message originally was posted to the BBS.

Out Tray

On creating a message and pressing Send on the message
form, the message is saved in the Out Tray. The
Date/time is set to “none.” Messages in this folder can be
opened, viewed, edited, and saved back to this location.
Only valid messages can be sent. A valid message
includes a message with all fields filled in and the Send
button was pressed.
Outpost checks this folder for messages addressed to the
currently selected BBS and sends these messages
regardless of type (Private, Bulletin, and NTS).

Sent Msgs

Once a message is sent to the BBS, Outpost moves the
message to the Sent Msgs Folder with the date and time
set to the time it was sent. This time may be different
from the time assigned by the BBS.
Messages in this folder can be opened, viewed, printed, or
forwarded to another BBS user.

Archive

This folder is an ad hoc message folder.

Draft Msgs

This folder contains messages that were not completed.
Only a Subject is required to Save a message to this
Folder.

Deleted Msgs

This folder contains all messages previously deleted from
all other folders.
Messages in this folder can be opened, viewed,

April 9, 2020
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Folders

Description
forwarded, replied to, or moved or copied to any other
Folder.
Deleting a message from this folder permanently deletes
it from Outpost.

User Defined

3.

Five additional folders are available to the user for their
own use. See the Tools > General Settings for naming
these folders.

Message List Area – The message list area is where messages residing in the
selected folder can be selected.
 Unread messages will be displayed in BOLD typeface. Once a message is read,
it will be displayed in regular (unbolded) typeface.


Messages created in Outpost that where Saved will be listed in BLUE text with
the word DRAFT in the Type field.



Once they are opened and the Send button is pressed, it changes to BLACK
text.

Only messages stored in the selected folder are displayed.
Field
U

Description
Urgent Flag. Messages sent to this station from another
Outpost client can be sent as URGENT. When these
messages are received, they are indicated by two RED “!!”
in the “U” column and the message list displayed in RED.
See the Message Form for the control to set a message as
URGENT.

Type

Indicates the message’s type and can contain one of the
following 3 types:
(blank) Private Message
B
Bulletin
NTS
National Traffic System Message
DRAFT Message is not complete and not ready to be
sent
For received messages, the Message Type is set by the
sender. For locally created messages, it is set based on
the option chosen at the time the message was created.

From

The originator of this message.
This field contains either an FCC Call Sign (current station
ID) or Tactical Call as assigned by the local emergency
organization.

To

The destination addressee of this message.
This field contains one or more of the following types of
addresses structures:
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Field

BBS

Description
 SMTP:name@domain for Winlink RMS/CMS access
 +ADDRESS_BOOK entry
The currently selected BBS.
For messages created in Outpost, this field contains the
name of the BBS that was set when the message was
created, and where this message will be sent. This allows
messages to be created for users on different BBSs, and
not sent until the BBS is selected using the Setup > BBS
menu.
For messages received from the BBS, this field lists the
BBS from where the message originated.

Local ID

Local Message ID.
Shows the Local Message ID (LMI) assigned to incoming
messages. Some jurisdictions require identifying all
messages – both outgoing and incoming – with their own
Message ID. When this option is turned on, the LMI will
be displayed here.
This option is controlled from the
Tools > Message Settings, Msg Numbering tab.

Subject

The subject of the message. On opening the message, the
entire 128‐character subject line is displayed.
NOTE: most BBS’s have subject lengths that are a lot
shorter than this. It is recommended to keep your subject
lines brief so they inadvertently do not get truncated in a
manner that you did not anticipate.

Date / Time

The Date and Time when the message was Posted on the
BBS.
For messages created and saved in Outpost (stored in the
Draft Folder) or Sent (stored in the Out Tray), this field
will be set to None.
After a message is sent to the BBS, it is moved to the Sent
Folder and the date/time is set to the time the message
was sent to the BBS.
For message received from the BBS and stored in the In
Tray, this field is set to the date/time that the message
was posted on the BBS.
For messages received from BBSs that maintain their time
in GMT/UTC, Outpost converts the time to Local Time
based on the Time Zone set up on your PC.
The format of this field is dependent on your PC’s
Regional and Language Option settings.

Size

April 9, 2020

Size of the message in Bytes as stored in Outpost.
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4.

Status Bar – The status bar is displayed at the bottom of the Outpost Form and
displays the following:
Item
Description
Message Count
Displays the number of messages (items) in the
currently displayed folder along with the number of
unread messages also in this folder.
Current Setup

Displays the currently selected settings: Station call
sign, the currently selected BBS, and the currently
selected TNC. The Tactical Call will also be displayed if
configured.

Time until next
Packet Session

When Send/Receive automation is selected, this 1st
timer shows the number of hours, minutes, and
seconds left until the next Send/Receive Session is
initiated.
If the timer shows 00:00:00, then no automation is
selected.

Current Time

3.3

The local system time in 24‐hour format.

Resizing the Display
Outpost lets you to change the widths of the columns, or hide a column if it is not
needed for viewing.

Figure 6: Resizing a column
To change a column width:
1.

Put the mouse cursor on the right side of a column header’s dividing line for
the column you want to change size.

2.

Left Click, hold the mouse button down, and move the mouse left to reduce
the column size or right to increase the column size.

3.

To hide a column, move the mouse all the way to the left until the field is
hidden.

4.

Double‐click on the dividing line will automatically resize the column to the
widest text in the column.

Also, there are some column and form re‐sizing controls on the Tools menu:
 Reset column widths: Resizes the columns to a default size.
 Pack column widths: Resizes the width of all columns to a width of the
widest text in each column for the current display.
 Reset form to normal: Restores the form to the default position.

April 9, 2020
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3.4

Getting ready to set up Outpost
In most cases, the steps involved with setting up Outpost need only to be
performed once. All setup options are stored in initialization files. There are 4
things that must be set up prior to running your first Packet Session. These are:
• Select an interface and define the device
• Configure the BBS
• Register your call sign with the BBS (if your BBS requires it)
• Confirm your user settings on the BBS
In preparation for defining these configurations, it is helpful to have any hardware
and BBS documentation that may be available. If none can be found, manually
interacting with the TNC and the BBS is the next best way to confirm you have
entered these configurations correctly.
In most cases, the default Outpost settings can be used when defining a TNC or
BBS. However, there is some information that is TNC‐ and BBS‐specific that must
be understood in order to complete the setup step.
These items are covered over the next 2 sections in this guide.

April 9, 2020
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4 Setting up Interfaces
Outpost can communicate with a BBS by one of three methods: direct serial port
(or USB‐to‐Serial adaptor) with a TNC, an AGWPE‐controlled TNC or other device,
or by a telnet connection. Setting up your interface is the first thing that you must
do to talk to a BBS. The Interface form can be found at Setup > Interfaces.

4.1

Defining the Interface Type
Depending on the type of interface that you select, the corresponding tabs will be
enabled. In the example below, the Device Type is a TNC that is connected to one
of the PCs Serial Ports or a USB‐to‐Serial adaptor. Note that the AGWPE and Telnet
tabs are disabled.
Outpost comes with examples of different interfaces already set up. Please use
these as examples when picking and defining a new interface.

Device settings are managed from the 6 tabs across the top of the Interface menu.
These tabs are:

April 9, 2020

Tabs
Interface Type

Description
Allows the user to define a new interface or select a
previously configured interface.

TNC Prompts

Enabled for a TNC connected to a Serial Port. This tab
holds the definitions of what the TNC prompts look like.
Defaults are specific for the KPC3 TNC, and generally
work for all others. For almost all cases, what is set as
the default will work. DO NOT CHANGE this unless your
TNC does not respond.
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Tabs
TNC Cmds

Description
Enabled for a TNC connected to a Serial Port; holds the
definitions of the different commands Outpost uses to
talk to the TNC.

Init Cmds

Enabled for a TNC connected to a Serial Port; holds
extra TNC commands that you may want to send to the
TNC both before and after a Send/Receive session. This
will be helpful to re‐initialize the TNC in the event
another packet program leaves the in a state that is
incompatible with Outpost.

Comm Port

Enabled for a TNC connected to a Serial Port; contains
the serial port configurations for this TNC.

AGWPE

Enabled for an AGWPE interface. This tab contains the
parameters needed for Outpost to talk to the AGWPE
monitor program.

Telnet

Enabled for a Telnet interface. This tab contains the
parameters needed for Outpost to talk to the BBS that
is Telnet‐accessible.

On the Interface Type Tab, the following fields are available:
Fields
Device Name

Description
A Pull‐down menu of the interfaces previously set up in
Outpost.
Default: Last interface type selected.

Device Name

When creating a new interface entry, the Pull‐down tab is
hidden and a fill‐in‐the‐blank Device Name field is enabled
so you can enter the name of a new TNC or interface.
While this is usually the TNC Model Number (i.e.: KPC‐3), it
can be some other friendly description such as KPC3‐P0
(port 0), JIMS‐KPC3+, etc.
The name can be up to 64 characters long.

Description

This is an optional free‐form text field for entering any
information about this TNC or interface.
This is a 256‐character field.

Device Type

Selects or displays the device type for the interface. When
creating a new entry, the user picks the interface type they
want to set up.
Default: TNC, TAPR TNC

The following menu controls are available:
Controls
New

April 9, 2020

Description
Lets the user set up a new interface type. All fields
throughout the menu are either cleared or set to their
default settings.
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4.2

Controls
Copy

Description
Copies or Clones the currently displayed interface. The
name of the current device is used along with the words
“COPY OF”. This name can then be changed, along with
the other fields for this interface.

Delete

Deletes the currently displayed TNC or interface. The user
will be prompted whether they really want to delete the
interface.

OK

Causes all fields to be validated as being filled in. On
completion, the menu is closed.

Apply

Same as the OK button, but the menu remains open. The
Apply button is enabled as soon as any field is changed or a
new interface is created.

Cancel

Cancels any changes that may have been made to the
form, and the form is closed.

Serial Port TNC Setup
A “Terminal Node Controller” (TNC) connects your computer to your radio, similar
to how a dial‐up modem connects your computer to the Internet by telephone.
Most TNCs implement some or all of the command‐set defined by TAPR (Tucson
Amateur Packet Radio Club). Outpost uses these commands as the default
commands when setting up your TNC. If your TNC’s command‐set is different, you
can change them when you define a new or update an existing TNC.
There are 4 tabs that are enabled to define the Serial Port TNC.

Prompts
This tab contains information on the prompts that the TNC will send back to
Outpost so Outpost knows what kind of response it got from the TNC.

April 9, 2020
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On creating a new TNC, the default prompts are loaded as shown below, and
should work fine for all TNCs. Check your TNC manual if a system hang occurs.
The fields on this form are:
Fields
Command

Description
The prompt that the TNC displays to prompt for the next
TNC command.
Default: cmd:
*

Timeout

(TAPR standard prompt)
(SCS TNC Prompt)

The string that is displayed by the TNC when the number of
configured retries is exceeded. Outpost uses this message
to detect a timeout and cancel the session.
Default: *** retry count exceeded

Disconnected

The string that is displayed by the TNC whenever the TNC
unexpectedly disconnects from the BBS. This is usually
caused if the BBS terminates the connection, or the user
forces a disconnect. Outpost uses this message to detect
this condition and attempts to cleanly exit the session.
Default: *** DISCONNECTED

TNC Commands
This tab contains the different commands that Outpost uses to manage the TNC to
prepare for and connect to the BBS. On creating a new TNC, the default
commands are loaded, and should work FINE for MOST TNCs. Check your TNC
manual if a system hang occurs.

NOTE! These fields must contain the TNC COMMANDS, not the responses. Only put TNC
commands in these fields.

April 9, 2020

23

Outpost Packet Message Manager v3.3 c081
Users Guide – Basics

Fields
Mycall

Description
The TNC command that is used to set the station ID. When
entering this command, only enter the TNC portion of the
command. Do not include your call sign.
Default: my

Connect

(short for MYCALL)

The TNC command that initiates a connection with a BBS.
When entering this command, only enter the TNC portion
of the command. Do not enter the BBS callsign.
Default: connect.

Retry

The TNC command that sets the number of attempts the
TNC will transmit a packet to the BBS before giving up.
Default: retry

Converse
Mode

The TNC command that puts the TNC into a converse
mode. This is used when Tactical Calls are used.
Default: reset

DateTime

The TNC command that is used to set the TNC’s date and
time. This command is transmitted each time a Packet
Session is initiated. If this field is left blank, no date/time
command is sent to the TNC.
Default: daytime

TNC Command Prefix. Some TNCs require a specific character to be set with TNC
commands to differentiate it from a string to be transmitted. For instance, the SCS
Tracker Modem requires the <esc> escape character to precede all commands sent
to the TNC.
Controls
Include TNC
Cmd Prefix

Description
When Unchecked, no TNC command prefix character is
sent. When Checked, the integer representing the
character to be sent (i.e.: 27 = Escape).
Default: unchecked
CHECKED, value=27

(TAPR Standard)
(SCS TNC)

Init Commands
This tab contains other TNC initialization commands that Outpost does not send.
You may need to send some additional TNC commands if you also use other packet
programs that do not always “clean up” after themselves in terms of resetting the
TNC to a known state.
The controls on this form are:
Controls
Initialization
commands

Description
Option: Never send…
Check this option if you do not want to send these
commands to the TNC.
Option: Send … during every Send/Receive Session

April 9, 2020
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Controls

Description
Check this option if you want to send these commands to
the TNC every time you connect to the TNC.

Fields
Commands
to send
before…

Description
Commands entered in this section will be sent after
Outpost sends it standard set of commands and before
connecting to the BBS. Enter a single command on each
line.

Commands
to send
after…

Commands entered in this section will be sent after
Outpost disconnects from the BBS and before
disconnecting from the Comm Port. Enter a single
command on each line.
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TNC Comm Port
This tab defines the serial port settings for the TNC. On creating a new TNC, an
initial configuration is loaded, but should be carefully checked against the serial
port configuration for the TNC you are using.

Comm Port settings are standard serial port settings typically used by other
terminal emulator programs. These settings define:
Fields
Port

Description
Identifies the Serial Port to which the TNC is connected.
Outpost will detect the list of available comm ports on your
PC, whether true hardware comm port or a USB‐to‐Serial
Port adaptor.
NOTE: The valid range of Comm Ports that Outpost
supports is 1 through 99.
Default: first Comm Port found if creating a new entry, or
None.

Max Speed

April 9, 2020

This is the baud rate between the computer and the TNC.
This is different from the speed that the TNC transmits data
to the BBS. Outpost Baud Rate settings include:
110
300
600
1200
2400
4800
9600
14400

19200
28800
38400
56000
57600
115200
128000
256000

Default: 9600
38400

(Standard TNC)
(SCS TNC)
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Fields
Data Bits

Description
The number of data bits to be sent.

Parity

Default: 8
Defines how parity will be handled
Default: None

Stop Bits

Default: 1

Echo

This setting is disabled and cannot be changed.

Flow Control

Default: On
Determines how the program will manage the data flow
between the Computer and the TNC. The following
options are available:
None:
RTS/CTS:

no flow Control is used
Hardware flow control

Default: RTS/CTS
Comments on Flow Control
Flow Control (also known as Handshaking) is a way for data communication
equipment to control the flow of data between connected equipment, particularly
when one part of the system is slower than the other. This is the case with the
TNC and BBS. While the PC running Outpost can connect and transfer data to the
TNC at a high data rate (such as 9600 baud in the example above), the TNC is
limited to transmitting at 1200 baud (or 9600 baud if your radio and BBS supports
it) with the BBS.
Because Outpost generates all the commands that you would typically enter, it
communicates with the TNC at a significantly faster rate than what you could
manually type. Therefore, there is the risk that Outpost will overflow the TNC’s
internal transmit data buffer. When this happens, the TNC and the Packet Session
Manager will hang.
The default setting is RTS/CTS (Hardware Flow Control). For this option to work,
you must have a serial cable between the TNC and Computer with at least the
additional CTS pin connected. To make it easy, I recommend using a full 9 pin
cable. If you have only a Pin 2 and 3 cable, leaving this setting as is will not have
any adverse effect. However, no flow control will occur and you should keep your
messages as short as possible to avoid overflowing the TNC’s transmit data buffer.
WARNING! Unshielded home‐made cables are a known source of problems that can cause
system and PC hangs. Most commercial cables are shielded. If you decide to make
your own, ensure the cable is shielded.

April 9, 2020
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4.3

AGWPE Setup
Per Ralph Milnes KC2RLM, “AGWPE is a multi‐TNC management utility written by
George SV2AGW. Before AGWPE, a packet device such as a TNC or other radio
modem could only be used by one program at a time. Likewise, a packet program
could only use one packet device at a time. AGWPE changed all that. It lets a
program access multiple packet devices at one time, and lets a packet device be
shared by multiple programs at one time.
“AGWPE performs this magic by placing the TNC in KISS mode and assuming
responsibility for handling most of the logic functions built into the TNC. The TNC
is left to handle just tone modulation/demodulation, or modem functions. AGWPE
also works with radio modems, such as the YAM and Baycom that already lack
logic functions and must rely on the logic functions of a control program such as
AGWPE.”
NOTE: For users wishing to use AGWPE, I strongly recommend that you thoroughly
understand how AGWPE works, how it is set up, and how it is confirmed
operational before using it with Outpost. AGWPE support is a field of study unto
itself and therefore, is out of scope for Outpost support. However, there is plenty
of help available from users on the Internet.
Outpost implements the required protocol to talk to AGWPE and its associated
TNC device located either on the same PC where Outpost is running or on a remote
PC somewhere else on the network.
The AGWPE setup form is enabled once AGWPE is selected as the device type.

AGWPE
This tab manages information specific for accessing the AGWPE program. On
defining a new AGWPE Interface, the default values shown above are loaded, and
should work for a locally configured AGWPE installation (same PC). The fields on
this form are:
Fields
Remote Host
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Description
The IP Address or host name of the PC where AGWPE is
running. The default setting tells Outpost to look for the
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Fields

Description
AGWPE on the local machine where Outpost is running.
Default: 127.0.0.1

Remote Port

Ports are used with TCP to name the logical connection on
a specific network node. This setting must match what is
set up in the AGWPE Winsock Interface form.
Default: 8000

Network
Timeout

(matches AGWPE’s default port number)

The network timeout tells Outpost how long to wait for a
network interaction with AGWPE before giving up and
reporting an error. A setting of 5000 milliseconds
(5 seconds) is plenty, particularly if AGWPE is operating on
the same PC as Outpost.
For remote instances of AGWPE, the timeout may need to
be longer depending on the network traffic.
Default: 5000

TNC
RadioPort

Corresponds to the TNC Radio Port setting defined on the
AGWPE Radio Port TNC Setup
Default: 1

AGWPE
Logon
Required

This control and the next 2 fields depend on you setting up
a logon requirement at the AGWPE program.
For AGWPE operating on the same PC as Outpost, no
Logon is usually required. Logon is optional for cases
where AGWPE is located somewhere else on the same
LAN, or elsewhere on the internet.
Check this box is a Logon is required.
Default: unchecked (not required)

Logon

If the above box is checked, then enter a logon name here;
it must match the name set up in AGWPE.
Check the AGWPE configuration for a Logon/password
requirement (AGWPE’s Winsock Interface Security tab).
Default: <blank>

Password

If the above box is checked, then enter a password here; it
here must match the password set up in AGWPE.
Check the AGWPE configuration for a Logon/password
requirement (AGWPE’s Winsock Interface Security tab).
Default: <blank>

April 9, 2020
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4.4

Telnet Setup
There are some BBSs that can be accessed by Telnet.
Similar to the AGWPE, setting up telnet requires an understanding of the network
settings that need to be defined. Unlike AGWPE, Telnet access to a BBS is usually
more tightly controlled resulting in the need to work with the BBS Sysop to
establish a telnet logon and password. This ensures non‐Hams cannot initiate
radio traffic on the Amateur Radio bands.
The Telnet setup form is enabled once Telnet is selected as the device type.

Telnet
This tab contains information specific to accessing a remote BBS over a LAN or
WAN. On defining a new Telnet Interface, default values are loaded, but are
insufficient to operate without additional information.
The fields on the form are:
Fields
Remote Host

Description
The IP Address or host name of the server where the BBS is
running. The default setting tells Outpost to look for the
BBS on the machine where Outpost is running. Contact the
BBS Sysop for the IP Address or host name.
Default: 127.0.0.1

Remote Port

Ports are used with TCP to name the logical connection on
a specific network node. Contact the BBS Sysop for the
Port number.
Default: 23

Network
Timeout

The network timeout tells Outpost how long to wait for a
network interaction with the BBS server before it gives up
and reports an error. A setting of 5000 milliseconds
(5 seconds) is plenty, particularly if the server is operating
on the same LAN as Outpost.
For remote instances of the server, the timeout may need
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Fields

Description
to be longer depending on the network traffic.
Default: 5000

Logon
Prompt

This is the string presented by the BBS that prompts for the
Logon Name. This entry must match exactly what the BBS
sends as a logon prompt. Watch the spaces and
capitalization.
Default: Callsign :

Password
Prompt

This is the string presented by the BBS that prompts for the
password. This entry must match exactly what the BBS
sends as a password prompt. Watch the spaces and
capitalization.
Default: Password :

4.5

Telnet Login
As mentioned, for Telnet access, you will need a login and password assigned by
the BBS Sysop. Once you have this information, you need to associate this
information with your call sign in Outpost.
Refer to the Outpost Application Note titled “Setting up Outpost v3.2 and Telnet
Access” in the Documentation link on the Outpost website.

4.6

Selecting a previously configured interface
If you decide to install the sample Outpost configurations, you can see some
commonly available TNCs, and sample AGWPE and Telnet interfaces already set
up. To select one of these configured TNCs, perform the following:
1.

From Outpost’s main form, select the Setup > TNC… If a TNC was
previously defined, it will be displayed.

2.

At the TNC Name: field, use the pull‐down menu to view the previously
configured TNCs.

3.

Select the TNC you want to use.

4.

Press OK when done. This TNC is now selected as the current TNC.

When done, Outpost will display the selected TNC on the Status Bar on the bottom
of the Main Form.

April 9, 2020
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Additionally, a previously used BBS‐and‐Interface pair can be selected from the
File Menu’s most recently used list. This lists all the combinations that were
previously selected in order when they were used, most recent on top.

4.7

Updating a previously configured Interface
Most TNC settings can be changed. To change a TNC setting, do the following:
1.
2.

From Outpost’s main form, select the Setup > TNC… If a TNC was
previously defined and selected, it will be displayed and loaded.
All fields (other than the TNC name) can be changed. When done, press
Apply or OK.

April 9, 2020
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4.8

Defining a new interface
Setting up a new Interface uses the menus described above. Depending on the
interface selected will determine which tabs on the menu will be enabled.
Set up a new TNC as follows:
1.

From Outpost’s main form, select the Setup > TNC…

2.

Press the New button.

3.

Enter the Device Name. A good rule of thumb is to enter the product or
model number for a TNC (such as KPC‐3, KAM, DSP232, etc.), or some
descriptive text for AGWPE or Telnet (such as AGWPE‐LOCAL, TELNET‐TO‐
WL2K). Device names can be up to 64 characters long.

4.

Enter any additional text in the description field you want about the TNC
(i.e.: location, etc.).

5.

For Serial Port TNC setups, the TNC commands are generally the same
from one TNC manufacturer to another.
Having said that, undoubtedly there are one or more TNCs on the market
that have a different command and/or prompt set. Because Outpost
issues TNC commands on behalf of the user, and looks for the TNC
prompts coming back, it is important that the specific TNC commands and
prompts required by Outpost are defined. If your TNC has a different
command‐set or prompt‐set from what is initially loaded, then you will
have to change the default settings.

April 9, 2020

6.

For Serial Port TNC setups, using the TNC’s reference manual, verify the
default TNC prompts are correct, or change them as necessary.

7.

Verify the default TNC commands are correct, or change them as
necessary.

8.

Verify the Comm Port settings are correct, or press the Comm Port button
to change them as necessary (see below for the Comm Port menu).

9.

Press OK when done. This new TNC entry and Comm Port settings are
saved and set as the current TNC.
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5 Setting up a BBS
The next step with setting up Outpost is to identify the Bulletin Board System (BBS)
you want to access.

5.1

Introduction
Wikipedia states: “A Bulletin Board System, or BBS, is a computer system running
software that allows users to connect and log in to the system using a terminal
program. Once logged in, a user can perform functions such as uploading and
downloading software and data, reading news and bulletins, and exchanging
messages with other users, either through electronic mail or in public message
boards.
“Originally BBSes were accessed only over a phone line using a modem, but by the
early 1990s some BBSes allowed access via a Telnet, packet switched network, or
packet radio connection.
“The term "Bulletin Board System" itself is a reference to the traditional cork‐and‐
pin bulletin board often found in entrances of supermarkets, schools, libraries or
other public areas where people can post messages, advertisements, or
community news.”
It is the “exchange of messages with other users” feature on which Outpost relies.
For our purposes, a BBS is simply a mail drop for packet messages. Packet BBSs
come in all different types and sizes with implementations in both hardware
(Personal BBSs as implemented in a TNC) and software, operating as either stand‐
alone or networked with packet messages shared across BBSs.
Because not all BBSs operate the same way, Outpost explicitly needs to know how
the BBS works to correctly access it. Today, Outpost supports the following PBBS
and BBS systems:
Firmware‐
based PBBSs

Software‐based
BBSs

April 9, 2020

KPC2, KPC2400, KPC3, KPC3+, KPC9612
KAM, KAM‐XL, KAM‐98 KAM Plus, KAM‐4
KWM1200, KWM9612
Kantronics’ Data Engine
PK‐88, PK‐96, PK‐232, DSP‐232
MFJ‐1270x, MFJ‐1274, MFJ‐1278
AA4RE
BPQMailChat
DXNET
F6FBB
HAMSERV
JNOS, SNOS, TNOS
MSYS
N0ARY
NNA
OpenBCM
Winlink RMS, CMS
W0RLI
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“Support” means that Outpost knows how to identify the BBS using its System
Identifier, determine the BBS prompt, and how to interpret the Message Listing
resulting from a LM, LB, or LT. For BBSs not listed here, see the BBS portion of the
Outpost website for instructions and criteria for getting a different BBS supported.

5.2

BBS Setup Menus
To get to the BBS form, select Setup > BBS. Outpost comes with some examples of
different BBSs already set up. Please use these as references when setting up a
new BBS.

BBS settings are managed from a series of tabs across the top of the above menu.
Tabs
Name
Prompts
Commands
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Description
Lets the user to select a previously defined BBS, or
define a new one.
Lets the user to enter the BBS prompts instead of
letting Outpost figure it out (NOT RECOMMENDED).
Defines the different BBS commands that Outpost will
use to talk to the BBS.

Init Commands

Optional: Lets the user enter additional BBS commands
to refine how the BBS may respond to Outpost.

Retrieving

Lets the user define which messages can be retrieved
from this BBS.

Path

Lets the user select the method of connecting to the
BBS: direct, digipeating, or through a sequence of KA or
Netrom Nodes located between your station and the
BBS.
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BBS Name
The following fields and controls are available on this tab:
Fields
BBS Name

Connect
Name

Description
A pull‐down menu containing the list of friendly names that
identify the BBSs currently set up in Outpost. Friendly
names allow different configurations to be entered for the
same BBS.
Default: Last BBS selected
The exact name of the BBS to which you want to connect.
This is NOT a friendly name (Bob’s BBS) but the call sign
and SSID (if used) of the BBS, such as K6FB‐2 or an alias
(SEABBS). This is the string that will be added to the TNC
“connect” command.
Default: blank

Description

This is an optional free‐form text field for entering any
information about this BBS.
Default: blank

BBS Type

Outpost supports 3 options on how to configure the BBS.
1.

Let Outpost determine the BBS and set up the
prompts
Outpost will identify the BBS based on the BBS’s
System IDentifier (SID) or some other unique sign‐on
introduction. It then determines the BBS prompt by
looking for the first occurrence of the “>” character,
and then looks back at the preceding line of text to
determine the BBS command prompt. When this
option is selected, the 2nd tab (BBS Prompts) is
disabled.

2.

User defines the BBS prompts
The user has the option of setting up the prompts
directly. This implies a more detailed working
knowledge of how the BBS works. This option would
be chosen because of some mitigating situation where
Outpost could not determine the BBS prompt
correctly. In general, DO NOT use this option.

3.

AA4RE BBS
This BBS is a non‐identifying BBS, meaning, it does not
identify with a SID. Checking this box ensures Outpost
knows this BBS is an AA4RE. However, the user needs
to know this. See the list of supported BBSs on the
Outpost website to compare the BBS message listing
to confirm what you have is really an AA4RE BBS.

Default: Let Outpost determine the BBS…

April 9, 2020
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Controls
New
Copy

Delete
OK

Apply

Cancel

Description
Lets the user set up a new BBS. All fields are set to their
default settings.
Copies or Clones the currently displayed BBS. The name of
the current BBS is used along with the words “COPY OF”.
This name can then be changed, along with the other fields
for this BBS.
Deletes the currently displayed BBS. The user will be
prompted if they really want to delete the BBS.
Causes all fields to be validated as being filled in. On
completion, the BBS information is saved and the menu is
closed.
Same as the OK button, but the menu remains open. The
Apply button is enabled as soon as any field is changed or a
new BBS is created.
Cancels any changes that may have been made to the
form, and the form is closed.

BBS Prompts
This tab is disabled for all BBS type selections except for the 2nd choice: User
defines the BBS prompts. This form normally will be blank and disabled (labels
and data fields) for all other BBS Type options.

The fields on the form are:
Fields
BBS
Command
Prompt

Description
The prompt that the BBS displays to prompt for the next
BBS command.
There is no standard BBS prompt. It you elect to custom
define the BBS prompts, it is recommended that you copy
the BBS prompt exactly so there is no mistake in its setup.
Default: none

Use default…
after Outpost
sends a
message
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After Outpost sends a message to the BBS, Outpost will
look for the string identified here and sent from the BBS to
know that the message was sent.
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Fields

Description
NOTE: Do not override this unless you are very sure of
what the BBS sends back under this condition.
Default: CHECKED, value defaults to the command prompt
if one entered in the BBS Command Prompt field.

Use default…
after Outpost
receives a
message

After Outpost receives a message from the BBS, Outpost
will look for the string identified here and sent from the
BBS to know that the BBS is finished sending.
NOTE: Do not override this unless you are very sure of
what the BBS sends back under this condition.
Default: CHECKED, value defaults to the command prompt
if one is entered in the Command Field.

WARNING! Changing the last 2 fields may result in unexpected results. Be very careful if you
decide to change these values.
WARNING! Also, even though this option exists, there is no guarantee that other assumptions
about BBS behavior will also fail to apply. When it doubt, it is better to try to get
your BBS supported then play with this.

BBS Commands
This tab contains the commands that Outpost issues to the BBS to send, list,
receive, and delete messages on the BBS. On creating a new BBS, the default
prompts are loaded, and should work fine for most BBSs.

The good news is that almost all BBSs in use today have essentially the same
command set for listing, reading, and deleting messages. This means that the
default commands with which Outpost starts should be fine in most situations.
The fields on the form are:
Fields
Send Private

Description
The BBS command that is used to send a Private Message.
Only the station to which this message is addressed can
read it.
Default: SP

April 9, 2020
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Fields
Send Bulletin

Description
The BBS command that is used to send a Bulletin Message.
Bulletins are usually addressed to a group of stations. All
stations can read bulletins.
Default: SB

Send NTS

The BBS command that is used to send an NTS Message.
NTS messages can be read by anyone who is willing to
service the NTS message.
Default: ST

List Mine

The BBS command that that produces the list of messages
addressed to you (your call sign or tactical call sign).
Default: LM

List Bulletin

The BBS command that produces the list of bulletins
present on the BBS.
Default: LB

List NTS

The BBS command that that produces the list of NTS
messages present on the BBS.
Default: LT

List Filtered

The BBS command that will produce the list of messages
that match the Filter Masks defined on the Send/Receive
Settings menu.
Default: L>
NOTE for JNOS Users: If this field is set to “L”, then
only new messages to be listed.

Read
Message

The BBS command that retrieves and displays a specific
message on the BBS.
NOTE: Do not replace this with the RM (Read Mine)
command. Outpost uses the R ### command to explicitly
read and handle one message at a time.
Default: R

Delete
Message

The BBS command that deletes a message on the BBS.

Bye/Log off

The BBS command that logs you off of the BBS.

Default: K
Default: B

April 9, 2020
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BBS Initialization
Contains other BBS commands that Outpost does not send but the user may want
applied before starting to send or retrieve messages.
After you connect, you may need to send some BBS commands to get the BBS
ready for an automated session.
For instance, the JNOS command “XM 0” turns off paging so that the BBS lists the
message in its entirety without prompting to view more lines. The use of this form
seems to be few and far between, but this capability does exist for users.

The controls on this form are:
Controls
Init
commands

Description
Option: Never send…
Check this option if you do not want to send these
commands to the BBS.
Option: Send … during every Send/Receive Session
Check this option if you want to send these commands to
the BBS every time you connect.
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Fields
Commands
to send
before…

Description
Commands entered in this section will be sent after
Outpost connects to the BBS and before starting the
message exchange. Enter a single command on each line.

Commands
to send
after…

Commands entered in this section will be sent after
Outpost completes sending and receiving messages with
the BBS and before disconnecting from the BBS. Enter a
single command on each line.
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Retrieving
This tab lets you to configure Outpost to selectively retrieve different types of
messages from the BBS:

Operation
Retrieve Private
Messages

Retrieve NTS
Messages

Description
Private messages are addressed to a specific
individual (Call Sign or Tactical Call). Once Outpost
retrieves and stores a private message, the message
is deleted off of the BBS (unless configured to do
otherwise).
Messages posted as NTS can be retrieved. Once
Outpost retrieves and stores an NTS message, the
user has the option to accept the message for
servicing and direct Outpost to delete it off of the
BBS. See the section on the Message Form for
details.
Not accepting the message for servicing leaves the
NTS message on the BBS for someone else to pick up.

Retrieve Bulletins >
All New Bulletins

Bulletin messages are addressed to anyone who can
access the BBS.
Outpost will not attempt to delete retrieved bulletin
messages off of the BBS.
If you originated the message and retrieved it, when
you view the message, the Expire button on the
message form is enabled. By pressing Expire, the
Bulletin will be deleted the next time you perform a
Send/Receive Session.
When this option is selected, the other retrieve
options are not available.

Retrieve Bulletins >
Selected Bulletins
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The selected messages are one or more messages
that satisfy the entered filter or mask. Outpost will
use the List Filtered command entered on the
Commands Tab (default is L>) followed by the
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Operation

Description
message filter entered here. At least 1 filter must be
entered.

Retrieve Bulletins >
Custom Retrieval

The NOS systems (JNOS, TNOS, SNOS) organize these
messages in Areas. Unlike the “Selected” option
above, getting to the bulletins is a two‐step process
as shown in this example.

Outpost will issue the JNOS Area Command to move
to the Area ALLWW, then issue two list commands:
L> EQUAKE (earthquake reports) and L> KEPS. It then
changes Areas again to XSCEVENTS and issue a LA
(List All) command.
HINT: to check what areas exist on your BBS,
manually connect to your BBS and enter the “area”
command.
Skip NTS
Messages I sent
to the BBS

Skip Bulletins
I sent to the BBS

NTS messages that you originate will normally be
retrieved.
If this option is checked, the NTS messages you
originated will not be retrieved, thereby reducing
channel contention by not downloading a message
that is likely to be still in your Sent Folder.
Bulletins that you originate will normally be retrieved.
If this option is checked, the bulletins you send will
not be retrieved, thereby reducing channel
contention by not downloading a bulletin that is now
currently in your Sent Folder.
However, you will not be able to delete this bulletin
without retrieving it and pressing the Expire button
on the bulletin’s message form.

Filtered Bulletin Retrieval Considerations
When Emergency Response Organizations rely on a networked BBS for their
message traffic where operational and non‐operational traffic may be present, or
when a BBS is used to post a variety of bulletin data, retrieving ALL bulletins is
neither an effective option nor an efficient use of the frequency.
Most BBSs offer one or more commands that allow the user to retrieve messages
based on the destination (To:) Call Sign or the message’s category (category @
route). Outpost supports the capability to selectively retrieve messages during a
Packet Session based on the message list‐matching capabilities of the BBS.

April 9, 2020
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A cursory check of a few BBSs shows that there are different commands for filtered
message listing. Some of these commands are:
L> string

List the messages where “string” matches the call sign of the
destination address; could match the category field in a
destination address (category @ route).
BBS: AA4RE, F6FBB, some TNC PBBSs.

L string

List the messages where “string” matches the category field
in the destination address (category @ route).
BBS: MSYS

A string
L

A (area) command followed by “string” moves the user from
the logged‐on area (i.e.: KN6PE) to the new area. The L (list)
command then lists the messages in the area.
BBS: JNOS, TNOS, SNOS, other NOS derivatives

NOTE: Check your BBS for the exact command options for selective or custom
retrievals.
The Filtered and Custom Retrieval Options are intended for selective retrieval of
BULLETIN messages. This means:
1.

The “Retrieve Private Message” option should still be used to retrieve
private messages addressed to you since Outpost will attempt to delete
private messages just retrieved off of the BBS.

2.

Selectively retrieved messages are bulletins; no attempt will be made to
delete them off of the BBS.

3.

Outpost BBS retrieval rules apply: if a selectively retrieved message was
previously downloaded and is still on Outpost, no attempt is made to
download it again.

Other Considerations
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If a Bulletin is sent to a specific individual (such as KN6PE) instead of a general
category (such as ALLCTY, etc.), that message will be picked up as a Private
message regardless of the BBS message setting and is subject to the Private
Message handling rules described above. However, the receiving Outpost
station will not be able to delete it because it was not the author of the
Bulletin. Only the originators of Bulletins can delete the bulletin.



NTS messages will be deleted from the BBS only after the user accepts the
message for servicing. If you have no intention of servicing an NTS message,
DO NOT ACCEPT THE MESSAGE. If you accidentally accept an NTS message,
please post it back to the BBS so someone else can service it.
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BBS Path
This tab defines how Outpost will reach the BBS.

Controls
Access
Method
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Description
One of three methods can be selected for accessing the
BBS over an RF path:
1.

Direct to BBS. This option means that Outpost will
connect directly to the BBS without any intermediate
nodes or stations in the signal path.

2.

Via Digipeater(s). The user cannot reach the BBS
directly and needs to use one or more digipeat
stations that may exist between the user and the BBS.
When selecting this option, the corresponding field is
enabled for input. One or more Digipeat stations can
be entered and separated by commas.

3.

KA-NODE/Netrom Access. Similar to the Digipeat
option, the user chooses to use KA‐ or Netrom nodes
to reach the BBS. When this option is selected, the
user can define one more nodes that must be used to
reach the BBS.
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5.3

Configuring for KA‐Node/Netrom access
Configuring for KA‐Node/Netrom access is not difficult, but does require an
attention to detail to get the settings right. Once you select this access method,
the Node Path fields are enabled.

NOTE: See the Application Note titled “Setting up KA‐Node/Netrom Network Access” on
the Outpost website for a more detailed walk‐through of this topic.

Fields
Node Name

Description
The actual connect name of a node in the node path, such
as K6FB‐7 or W6TDM‐7.
Default: blank

Successful
Connect
Message

This is the string that is returned by the node indicating
that you are connected. Outpost uses this string to confirm
that the connection was successful, and is ready to either
connect to the next node in the sequence or connect to the
BBS.
Default: blank

Connect cmd
to the next
node/BBS

Some nodes support multiple channels that allow you to
connect to a different channel. While the “C” connect
command is typical, other commands could be used, such
as “X” for Xconnect (cross‐connect), or “BBS”.
Default: C

Connect with
node/BBS
name

Some nodes are actually the host access point to a local
BBS and does not require a full “c bbs_name” as the final
command. Instead, by setting up the previous field as
“BBS” connects the user directly to the BBS.
NOTE: This is network‐ and BBS‐dependent.

Default: CHECKED

April 9, 2020
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Fields
Port Number

Description
The port number to be taken from the current node to the
next node. Some nodes have multiple radio ports typically
set up on different bands.
For single channel ports, leave this value as 0.
Default: 0

Unsuccessful
Connect
Message

In the event the connect request to the next node was
unsuccessful, this string is returned by the current node to
tell Outpost that the next connect was not successful.
Default: blank

Controls
New

Description
Clears the form and prepares to receive information about
a new node. All new nodes are added to the end of the
node list.

Delete

Deletes the displayed node from the node list.

Next

When multiple nodes are defined, displays the next node in
the sequence.

Previous

When multiple nodes are defined, displays the previous
node in the sequence.

Move Up

Moves the displayed node up (earlier) in the sequence.
This is typically used when an intermediate node is added.
All new nodes are added to the end of the node list and
may need to be positioned earlier in the list.

Move Down

Moves the displayed node further down (later) in the
sequence.

Configuring a Node Path
To configure any node path, perform the following steps:
1.

Collect information about the path to the BBS

2.

Perform the connection manually before starting any Outpost setup

3.

Record the relevant information for each node that you will need for the
Outpost setup

4.

Configure Outpost (and your BBS) for Node access

5.

Test the configuration

Considerations about using Node Path


Your understanding of the node path to get to the BBS is critical. I recommend
developing a worksheet that includes the following:

Node #

Node Name

Successful Msg

Connect
command

Connect
with name

Port

Unsuccessful Msg

1

K6KP-7

Help ?

C

checked

0

###RETRIED

2

W6TDM-3

###LINK MADE

C

checked

0

3} Failure with

3
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To develop the Successful Connect Messages, manually run through the
sequence and record what each node returns. Usually, only the last couple of
characters in the string are required. For instance, for Node 1 above, the
entire returned string was: “ENTER COMMAND: B,C,J,N, or Help ?”.
However, only the “Help ?” is all that is needed. As usual, watch the spaces
and capitalization.
Most Netrom nodes do not return anything after a successful connect.
However the calling station does report that the link was made (Node 1 was a
KPC3 KA‐Node and returned the string: ###LINK MADE when connecting to
Node 2, which did not return anything). This string is a suitable proxy for the
Netrom connect string. See Node #2 above.



To develop the Unsuccessful Connect Messages, you will have to manually
force the error by entering a non‐existent node and recording what is
returned.
When picking the error string, DO NOT pick any portion that includes a call
sign since this may change at runtime. For Node #2 above, the first portion of
the error message was picked up and was deemed to be unique regardless of
the next station to which it tried to connect.

NOTE: See the Outpost Application Note titled “Setting up KA‐Node/Netrom Network
Access” on the Outpost website for a more detailed walk‐through of this topic.

5.4

Selecting a configured BBS
If you decide to install the sample Outpost configurations, you can see some BBSs
already configured that are mostly found in San Francisco’s South Bay Area. For
those Outpost users outside the Bay Area, please use these as examples on how a
completed BBS setup should look. If desired, these BBS entries can be deleted
from the list.
To select a previously configured BBS, perform the following:
1.

Select Outpost’s Setup > BBS…

2.

At the BBS Name field, use the pull‐down menu to view the previously
configured BBSs. If a BBS was previously defined, it will be displayed.

3.

Select the BBS you want to use.

4.

Press OK when done.

Outpost will display the selected BBS on the Status Bar on the bottom of the Main
Form.

April 9, 2020
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Additionally, a previously used BBS‐and‐Interface pair can be selected from the
File Menu’s most recently used list. This lists all the combinations that were
previously selected in order when they were used, most recent on top.

5.5

Setting up a new BBS
Before beginning, you are strongly encouraged to ensure you can access the BBS
from either the Outpost’s Interactive Packet Program or some other TNC program
to verify the path and confirm it works before trying it with Outpost.
Set up a new BBS as follows:

5.6

1.

Select Outpost’s Setup > BBS…, then press the New button.

2.

Enter a Friendly Name. This is the name that you can use to identify the BBS.
It can be the BBS call sign (K6FB‐2), personal reference (Bobs JNOS), or other
description that you wish to use.

3.

Enter the Connect Name. This is the exact name of the BBS as you would type
it to initiate a connection (such as: K6FB‐2, W6XSC‐1, etc.).

4.

Select the BBS Type. The recommended option is the default option: “Let
Outpost determine the BBS…”

5.

If you cannot reach the BBS from your station, on Tab 4 “BBS Path”, choose
the path option based on the types of stations between you and the BBS.


For Digipeater access, check this box and enter one or more digipeater
stations (limit is 128 characters / about 9 digi‐stations… worst case).



For KA‐, Netrom Node access, see the Application Note titled “Setting up
KA‐Node Network Access” on the Outpost website for setup details.

6.

Verify the default list of BBS commands; change any of them if necessary.

7.

Press OK. This new BBS entry is saved and set as the current BBS.

BBS Registration
The typical Outpost Packet Session assumes there are no superfluous prompts
such as prompting for the user’s name, zip code, city, etc. However, some BBSs
require this as part of the registration process the first time you log on.

April 9, 2020
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 If you intend to access a BBS that requires registration, you must log on
manually and register prior to running Outpost.
 If you run Outpost and the program hangs because of registration prompts,
Press the Abort Session button, wait for Outpost to end and close the Packet
Session Manager window, then manually connect to and register with the BBS
using either Outpost’s Interactive Packet Program (under the Tools >
Interactive Packet menu) or some other terminal emulator program.


5.7

Log on manually to confirm the registration was successful.

BBS Expert User Mode
Several BBSs provide different levels of prompts.
 The NEWUSER mode presents different prompts that guide the new user
through the use of the BBS.
 The EXPERT mode assumes the user is familiar with the BBS and its commands,
and presents only the BBS Command prompt.
Outpost only works in EXPERT Mode and does not expect to see any other prompt
other than the BBS command prompt. If your BBS supports it, before beginning an
Outpost Packet Session, verify your logon is set for EXPERT.
See the Outpost Website for specific commands that will help put you in Expert
Mode and turn off Paging.
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6 Setting up Profiles
6.1

Introduction
Most of Outpost’s configuration settings are stored in an initialization file. Profiles
are essentially different combinations of Outpost settings stored under different
profile names. Profiles are user‐defined based on your specific needs. Once
defined, you can switch from one profile to another. Your current settings can be
set up to be saved prior to the profile change.
An Example
The typical use of Profiles may be for the user who uses packet for casual use as
well as in support of a local drill and emergency. For instance, here is an example
of 2 profiles that were created by this user.
Jim KN6PE uses Outpost for both casual and emergency use. When he is
cruising the packet‐sphere, he uses his Outpost Profile. Using his own call sign,
he goes to his favorite BBS and likes to check for personal messages,
information on RACES, and updates on satellite Keplerian elements.
When he participates in any city or county drills, he switches to his Emergency
Profile. He has set up to use a tactical call, the local emergency BBS, and other
settings that align with the packet procedures and policies of the county’s
RACES team.
Profile Name

Outpost

Emergency

Station ID
Setup > Identification

KN6PE
Msg ID Prefix = 6PE

K6KP

Tactical Call
Setup > Identification

 Use Tactical Call

 Use Tactical Call

Additional ID Text
Setup > Identification

<blank>

Cupertino EOC

BBS Friendly Name
Setup > BBS

K6FB‐2

W1XSC‐1

Automation
Tools > Send/Receive Settings

 No Automation

 Schedule a S/R session

 Retrieve Private messages
 Retrieve Bulletins
 Add Msg numbering
 Add Local Msg number
 Auto‐delivery Receipts

 Retrieve Private messages
 Retrieve Bulletins
 Retrieve Selected Bulletins
 Retrieve Custom Bulletins
 Add Msg numbering
 Add Local Msg number
 Auto‐delivery Receipts

 Auto‐Start Opdirect…

 Auto‐Start Opdirect…

 Show Station ID on startup
 PC Time Check

 Show Station ID on startup
 PC Time Check

Retrieving
Tools > Send/Receive Settings

Message Numbering
Tools > Message Settings
Tracking
Tools > Message Settings
Adv
Tools > Message Settings
Miscellaneous
Tools > General Settings

April 9, 2020

Tac Call=<unchecked>

Tac Call=CUPEOC
Msg ID Prefix = CUP
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6.2

Setting up a new Profile
On installing Outpost for the first time, the “Outpost” profile is loaded as shown on
the top of the Outpost main form.

1.

Any configuration changes made are stored in the Outpost Profile.

2.

To create a new Profile, select Setup > Profiles > New…

3.

When prompted, enter the Profile name… and then press OK.

4.

Outpost saves the current profile, and uses the settings from that profile to
create this new profile.

5. All updates made to Outpost from this point onward will become part of this
new profile, until another profile is created or selected.

6.3

Changing Profiles
1.

6.4

Profiles are selected from the drop‐down box on the main Outpost form.
When Outpost runs, the last profile used will be loaded as the current profile.

Deleting Profiles
To delete a Profile, select Setup > Profiles > Delete…
1. Select the profile to be deleted from the drop‐down list. Press OK to delete the
profile. The next Profile in the list will be loaded as the current profile.
2. In the event you delete all profiles, Outpost will re‐create the Outpost profile
with the program’s initial installation default settings.

6.5

Profile Locking
For organizations that use a common PC or laptop for their response, there may be
times when you want to make sure that profile changes are minimized, or at least
managed. Outpost gives you the option on how profiles would be saved.
Profile Save settings are universal to all profiles. So, their setting is independent of
the profile that is selected.
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Under the menu Tools > General Settings, there is a Tab labeled Profiles. The
controls located here determine if and when a profile would be saved.

Profile Save settings are universal to all profiles; the setting is independent of the
profile that is selected.
The three profile save options are:
Controls
Always

Description
Outpost will always save the current settings to the current
profile whenever the program is shut down, or a new
profile is selected. This option is good whenever the

Prompt

Outpost will prompt the user whether they want to save
the current settings before shutting down, or switching
profiles.

Never

Any changes made to the system settings will not be saved.

Limitations: Not every configuration change is captured in a profile. While the
name of the TNC and BBS are stored in the profile, changes to any TNC or BBS
configuration options are not captured.

6.6

Profile Considerations
1.

There no limit to the number of profiles that you can define. However, the
more you create, the more variations in Outpost configurations you need to
keep track of.

2. If you tend to use more than one call sign for different needs, I recommend
leaving Tools > General Settings, “ Show Station ID on startup” checked
so you can see if a call sign or tactical call change was made.
3. There is no way to directly rename a profile. However, if you do want a profile
under a different name, create a new profile with the new name and delete the
old one.
4. And, as is the case when changing BBSs, when picking a new profile for a
different BBS, you still need to change the frequency of your radio to align with
the profile.

April 9, 2020

52

Outpost Packet Message Manager v3.3 c081
Users Guide – Basics

7 Working with Messages
7.1

Introduction
Sooner or later, you will want to create and send a message. This is where
Outpost’s Message forms come in. There are two ways to get to these forms:
1.

From Outpost’s Main window, you can create a new message by either
pressing the New button, or the Actions > New Message menu. Or,

2.

You can view an existing message by highlighting the message with the
mouse, then either press the Open button, select the Actions > Open a
Message menu, by highlighting a message and pressing the “Enter” key,
or double‐click on the message.

NOTE: With the In Tray selected, new unread messages are listed in BOLD. Urgent
Messages are listed in RED!!
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The message form helps get a message put together quickly and formatted the
way you want it to look. Several fields are automatically filled in, and the Tools >
Message Settings form provides plenty of controls and options that further
enhance the message creation process.

7.2

The Edit Message Window
This form lets the user create and edit a message prior to it being sent. Note that
in the figure below, all fields are enabled and are available for editing.

NOTE: Some of the more common menu items are also implemented as Tool Bar buttons.
See the associated menu item below for their description.
Menu
File

Description
Send. Verifies that all fields are filled in and moved
the message to the Out Tray. Any missing fields will be
highlighted in Yellow. The Send button on the form
performs the same action.
_________________________________________
Open a File. Reads a text file and loads it in the
message body.
Open a Report. Reads an on‐line report file, loads it
in the message body, and initiates On‐line report
processing.
Save. Saves the message and closes the form. If this
message was just opened, Save writes this message to
the Draft folder
Save As. Allows the user to save the message to an
ASCII text file on the system disk. Address information
is also saved, but not in a format that can be reloaded
back into the message heading fields.
Save As, No Headers: Saves the body of the
highlighted message to an ASCII text file without the
message headers (From, To, Date, Subject).
See the General Settings menu for information on
enabling this feature.
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Menu

Description
NTS Message Maker. Calls the NTS Message
creation form. This form picks up and creates a
properly formatted NTS message. It also causes the
message to be sent as an NTS message.
_________________________________________
Process a Report. Causes Outpost to initiate forms
processing to collect user data. See the On‐Line report
HOW‐TO for details.
Clear remaining prompts. Causes Outpost to
remove any remaining on‐line report prompts and gets
the message ready for sending.
_________________________________________
Print. Allows the user to select a printer, and then
print the currently highlighted message to the printer.
Print, No Headers. Same as Print above, but no
message header (BBS, From, To, Subject, Date) is
printed.
Print Setup. Allows the user to select a default
printer for Outpost.
_________________________________________
Close. Closes the form without saving or sending any
message started.

Edit

Cut: Copies and removes any highlighted text in any
field. The text is placed in the MS‐Windows clipboard.
Copy: Copies any highlighted text in any field. The
text is placed in the MS‐Windows clipboard.
Paste: places any text from the clipboard into any
field.
_________________________________________
Select All: Selects all text in this message.
_________________________________________
Delete Message: Deletes this message without
saving.

Actions

Reply: Not used for new messages.
Forward: Not used for new messages.
_________________________________________
Send as a Private Message: Sets the message to
be sent to another user. Same as the “Pvt” button.
Send as an NTS Message: Sets the message to be
sent as an NTS message. Same as the “NTS” button.
Send as a Bulletin: Sets the message to be sent as a
bulletin. Same as the “Bul” button.
_________________________________________
Request a Delivery Receipt: Tells the receiving
Outpost station to send back a Delivery Receipt when
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Menu

Description
this message is downloaded.
Request a Read Receipt: Tells the receiving
Outpost station to send back a Read Receipt when this
message is opened.
_________________________________________
Encode Base64. Causes the message to be encoded
as in Base64 as described in RFC 2045. This encoding
is useful if there is binary data in the message or to
address 127‐character line limitations as is the case
with the JNOS BBS.
WARNING! Base64 incurs a 33% overhead penalty.
This means, a 750‐byte message will be encoded to a
1000‐byte size. Use sparingly.
_________________________________________
Keep ICS213 local. This causes locally created
ICS213mm messages to be reset as a received
message, thereby allowing another local ICS213mm
user to retrieve the message. In this case, Outpost
acts more as a local message server for an ICP or EOC.
Open enhanced message in client: For Addon
messages, this option causes the message to be sent
back to its native message client program for viewing.
_________________________________________
Font: Lets the user change the font for all messages.
Reset Font: Resets the font to the default Outpost
standard setting.
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Windows

Reset form to Normal: Occasionally, the form will
get stuck in either a minimized state or a maximized
state, and cannot be restored to a movable window.
This button resets the form to the default setting.

Help

No On‐line help enabled. Points the user to this User
Guide.
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7.3

The Viewing Message Window
This form is for viewing received messages (In Tray) or sent message (located in the
Sent Folder). None of the address or message fields are can be changed.

NOTE: Some of the more common menu items are also implemented as Tool Bar buttons.
See the associated menu item below for their description.
Menu
File

Description
Save As. Allows the user to save the message to an
ASCII text file on the system disk. Address information
is also saved, but not in a format that can be reloaded
back into the message heading fields.
Save As, No Headers: Saves the body of the
highlighted message to an ASCII text file without the
message headers (From, To, Date, Subject).
See the General Settings menu for information on
enabling this feature.
_________________________________________
Print. Allows the user to select a printer, and then
print the currently highlighted message to the printer.
Print, No Headers. Same as Print above, but no
message header (BBS, From, To, Subject, Date) is
printed.
Print Setup. Allows the user to select a default
printer for Outpost.
_________________________________________
Close. Closes the form without saving or sending any
message started.

Edit

Copy: Copies any highlighted text in any field. The
text is placed in the MS‐Windows clipboard.
_________________________________________
Select All: Selects all text in this message.
_________________________________________
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Menu

Description
Delete Message: Deletes this message without
saving.

View

Packet Header. Shows the details on the received
packet header that is not copied into the body of the
message.

Actions

Reply: For an existing message, opens a new
message window, initializes the address fields, and
formats the original message as a Reply Message.
NOTE: BBS field is set to the BBS from where this
message came.
Reply to All: Similar to Reply, this option is enabled
when a message is received from a Winlink RMS, CMS
node, or JNOS BBS and has multiple addressees in
the To: field.
Forward: Forwards the message by opening a new
message window, initializes the address fields, and
formats the original message as a Forwarded Message.
NOTE: BBS field is set to the currently defined BBS,
not necessarily the BBS from where this message
came.
Set to Unread: Resets the message to an Unread
state; it is displayed in the message list with BOLD
Text.
Resend: This option allows you to resend a
previously sent message, either with the same
message ID or with the next assigned ID. All fields are
available for editing when Resend is selected.
NOTE: For Addon messages, the New Message ID
option is disabled to ensure message integrity.
_________________________________________
Add Address: This option is enabled when an
address book packet message is received. Outpost lets
you send Address Book entries to other users. When
an Address Book entry is received, the user can add
this address to the local Outpost Address Book.
Change Route: This option is enabled when an
ICS213mm message is received. This menu lets the
user change the message routing to a different named
Ics213mm.exe user. See the ICS 213 Message Users
Guide for details.
Copy to Ics213mm format: This option lets the
user use a standard packet message to create an
Ics213mm packet message. You will be prompted for
additional Ics213 fields to complete the message.
Open enhanced message in client: For Addon
messages that only open in the message text window,
this option causes the message open in its native
message client program.
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Menu

Description
_________________________________________
Font: Lets the user change the font for all messages.
Reset Font: Resets the font to the default Outpost
standard setting.

Windows

Reset form to Normal: Occasionally, the form will
get stuck in either a minimized state or a maximized
state, and cannot be restored to a movable window.
This button resets the form to the default setting.

Help

No On‐line help enabled. Points the user to this User
Guide.

Archive

Closes and moves the message to the Archive folder.

Expire or Accept

Tool Bar only – The label on this button changes
depending on the type of message being viewed:


A

7.4

A

1.

For received PRIVATE messages, this button is
hidden.

2.

For received BULLETINS that you send, this button
displays Expire. By pressing this button, you are
prompted to confirm that you want Outpost to
delete your Bulletin off of the BBS during the next
Send/Receive Session.

3.

For NTS messages that someone else sent, this
button says Accept. By pressing this button, you
are agreeing to service the NTS message that is
open, and want Outpost to delete the NTS
message off of the BBS during the next
Send/Receive Session.

Previous / Next message. With this form open, this
control closes this message and opens either the
Previous () or Next () Message in the current list.
Two buttons, decreases (smaller A) or increases (larger
A) the font size on the message forms.

Address information
Field
BBS

Description
When opening a new message, this field is set to the
currently selected BBS. However, it could be changed
to a different BBS if desired.
For received messages, this field contains the name of
the originating BBS.

From

For new messages, this field is set to the currently
configured Station Call Sign or Tactical Call (if enabled).
NOTE: This field cannot be changed once the message
form is open. To change, close the message, go to
Setup > Identification, and name the operator change
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Field

Description
there.
When viewing a received message, this field contains
the Station Call Sign or Tactical Call of the sending
station.

To

Outpost supports three types of addresses:


FCC Call Sign or Tactical call of the station to which
this message is to be delivered.



Hierarchical addressing is supported for
forwarding beyond the BBS. This is in the form
(i.e.): KN6PE@N0ARY.#NCA.CA.USA.NOAM.



Internet email addressing will only work for BBSs
that support internet forwarding, such as Winlink,
JNOS, and BBQ Mail Chat to name a few. The To:
Field can hold multiple addresses separated by
semicolons.
A Winlink address can be any legal call sign or an
internet email address. Email addresses must
have the “SMTP:” prefix so that the destination
address looks something like this:
SMTP:kn6pe@arrl.net.
Tactical Calls cannot be used with the Winlink
system without previously setting them up.

For new messages, destination addresses can be
entered directly or as part of an Address Book entry
(alias or distribution list). Additionally, one or more
entries can be entered at a time thereby sending the
message to one or more recipients. This happens
differently depending on the BBS that is being used.
For received messages, this field contains the address
of the destination station. For Winlink, all destination
addresses are listed.
NOTE: See Section 9 Using the Address Book for
details on setting up Distribution Lists.
Subject

For new messages, enter a subject for this message.
When viewing an existing message, this field contains
the subject of the message.

7.5

Sent Date

This is the date/time listed with the message on the
BBS and acts as the message’s Post Date/Time.

Received Date

This is the date/time when the message was actually
received by Outpost. This field only is displayed on
Received messages.

Message Area
The Message Area is a free‐form text area that supports cut and paste, tabs, word‐
wrap, text importing, and other simple formatting functions. Rich Text formatting
is not supported.
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Because of packet’s ultimate transmission speed, packet messages should be long
enough to convey the intended meaning while being short enough to conserve
bandwidth and minimize channel congestion.
NOTE: Most HF BBSs have a 3,000‐character limit on packet messages. If you must send
large messages, it is recommended that you break them up into smaller messages
to reduce channel contention.
NOTE: There is no character limit for sent and received messages with Outpost.

7.6

Creating a message
The steps for creating a message are:
1.

From the main Outpost Window, click on the New button. A new message
form will open. The BBS: and From: fields will be pre‐loaded with the current
system information. These can be changed if necessary.

2.

Enter the To: (Destination) call sign or tactical call sign. For Winlink, multiple
addresses can be entered when separated by a semicolon. Or, you can enter
an Address Book entry by pressing the To: button. See Section 9 Using the
Address Book for details.

3.

Enter the Subject:. Up to 128 characters of subject can be entered. However,
this does not imply that the receiving BBS can actually support that number of
characters.

4.

Enter the Message. Outpost will wrap around any text that reaches the right
side of the form. If you are sending it to another Outpost station, line‐wrap is
handled correctly and all formatting is preserved

NOTE: For non‐Outpost users, the message may not look as “neat” at the receiving
end due to limitations of the receiving program and its ability (or inability) to
handle line wraparounds.
5.
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Verify the message type. The default message type is a Private message. To
change this, from the Actions Menu or Tool Bar buttons, set the message type
if you want something different other than a Private message. The message
type is displayed in the highlighted area below the Tool Bar buttons.
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7.7

6.

When you are done writing your message and satisfied with the way it looks,
press the Send button. The message is placed in the Out Tray and will be
transmitted during the next Send/Receive Session.

7.

If you are not done, you can press the Save button. The message is saved
into the Draft folder. You can retrieve, edit, and Send it later.

Creating an Urgent Message
Outpost allows you to set a message so that it is indicated as an URGENT
message at the receiving end. To do this, proceed as follows:

7.8

1.

On the Message form, press the Urg button (A). The message header (B)
shows it is to be sent as an Urgent Message. Pressing the Urg button again
changes the message back to non‐urgent.

2.

Once the message is retrieved by the receiving station, it is listed in the In Tray
with all the other messages, and indicated as Urgent by 2 red “!!” in the “U”
(Urgent) column, and a highlighted message listing in RED (C).

3.

The message will continue to remain listed in red until it is deleted from
Outpost. The message will also change from BOLD text to unbolded text to
indicate that it has been opened and read.

Requesting Message Receipts
Outpost allows you to request a Delivery Receipt and a Read Receipt from the
receiving Outpost station.
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A Delivery Receipt is a request for notification that the message you sent was
actually downloaded by Outpost at the receiving station. It does not mean
that it was stored on the BBS. Once the receiving station retrieves its packet
messages, Outpost formats and sends back a short Delivery Receipt message
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during the same Send/Receive Session


A Read Receipt is a request for notification that the sent message was actually
opened. It does not guarantee that the message was actually read or
understood. When a received message containing a Read Receipt is opened,
Outpost formats and sends back a short Read Receipt message during the next
Send/Receive Session.

Both Delivery and Read receipts can be requested at the same time if desired.
To request a delivery or read receipt, from the message form, press
Actions > Request Delivery Receipt or Request Read Receipt.

After the message is delivered to the receiving station, the requesting station sees
the following:



An entry in the message listing indicating a Delivery Receipt (B)



A short Delivery Receipt message containing date and time details of the
receipt.

A similar message listing and message is returned for Read Receipts.
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7.9

Forwarding or Replying to a message
Messages that you receive from another packet station can be forwarded to a
different user, or replied back to the originator. Outpost helps with the formatting
so that the original message can be referenced.
1.
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Forward. After you select a message for viewing from the Outpost main
window, you can press Forward. This action does the following:


A new copy of the message is created and reformatted with an
“original message” header. The original message is preserved.



The From: field is set to the current Station Call Sign.



The To: Field is cleared; set to the station to receive this message.



The user can now add or edit the text message as appropriate.



Press Send when done.
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2.

Reply. This command operates exactly the same as the Forward with
the following exception:
•

The From: and To: fields of the original message are swapped so that
the message will be sent back to the originator.

7.10 Forward and Reply Considerations
1.

The Forwarding and Replying feature does add text to the message that
(i) may not always be needed, and (ii) consumes channel bandwidth. This
should be of particular concern if the packet channel is heavily used.
If you need to reply to a message, consider editing the original message of
unnecessary text to reduce the message bulk, provided you do not alter
the meaning you want to communicate. Your organizational policies on
handling Forwards and Replies should be considered.

2.

When replying or forwarding a message, the message type is set according
to the Message Settings found at Tools > Message Settings.
Regardless of the setting, you can override this setting from Actions
Menu by setting the message type as described above (Private, NTS, or
Bulletin).

7.11 Sending a text file
The text of the message can also originate from a text file created elsewhere. To
import a message from a text file, do the following:
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1.

From the main Outpost Window, click on the New button. Fill on the To:
and Subject: fields.

2.

Select File > Open. Navigate to the directory where the file resides and
select the file. Press OK.

3.

The text will be loaded into the Message area and the message title is set
to the text file name.
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8 Customizing Message Settings
8.1

Introduction
While Outpost works fine out of the box, it does provide several options for
controlling how the program behaves, particularly around Message Settings.
There are several options that you can set to control how messages are handled.
These settings are accessed from the main Outpost menu
Tools > Message Settings…

The form is made up of a series of Tabs across the top. These tabs are:
Tabs
New Messages

Description
Describes how new messages are set up. See the field
descriptions below.

Msg Numbering

Set up message numbering options.

Replies/Forwards

Chooses how replies and forwards are handled.

Receipts

Allows the user to set global Delivery and Read Receipt
requests.

Deleting

Controls for what happens when you delete a
message.

Advanced

The controls on this tab are used for interacting with
external programs that can create messages in
Outpost.

The following sections describe these tabs in detail.

April 9, 2020

66

Outpost Packet Message Manager v3.3 c081
Users Guide – Basics

8.2

Settings for New Messages
First Tab: This menu controls how messages are created.

Figure 7: New Messages Tab
This set of options control how Outpost handles new messages.
Control Group
Message Type
Default:

Description
Set Default to Private: When set, a new message
defaults as a Private message. Usually, most messages
are sent as Private Messages to ensure that only the
recipient sees the message.
Set Default to Bulletin: When set, a new message
defaults as a Bulletin.
Set Default to NTS: When set, a new message
defaults to NTS. Note: The NTS Message Maker form
will not open when a new message is created.
Default: Set as Private

Create and Send
NTS messages as
Private messages

Several users prefer the NTS message format for
passing messages with the intent for their messages to
stay “local”. In these cases, the standard NTS address
that Outpost generates is not required.
This option overrides the NTS addressing controls and
allows the message to be created and sent as a Private
Message.
When checking this option, on sending a message, the
SP (Send Private) command is used instead of the ST
(Send Traffic) command. The user needs to fill in the
destination.
Default: UNCHECKED
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Control Group
Default Destination

Description
For stations operating in the field or at a local
municipality, it may be typical for them to address the
bulk of their message traffic to the same Operational
Area EOC or some other station.
To reduce the risk of addressing errors, the user can
enter a default destination address. To use this
feature, check the Default Destination box, and then
enter the destination address in field provided.
The next time a new message is created, the To: field
on the message form is automatically filled in with this
address. If necessary, this field can be subsequently
changed for “one‐off” messages going elsewhere.
Default: Not Set

8.3

Settings for Message Numbering
This menu controls how the Message Identifier is applied.

Outbound Message Identifier
It is good operating practice (if not a requirement of your organization) that all
messages be uniquely identified so that they can be subsequently referenced. This
option automatically places a unique message identifier in the subject line for each
message created.
To turn on this feature, do the following:
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1.

On this form, press the Edit Subject Line Identifier values button, or
Select Tools > Report Settings...

2.

Verify the “Next Message Number” field is set to the first number with
which you want to start your message numbering.

3.

Verify the “Tactical ID” field is set to any special 3‐character string
identifier you may be using. This field is Optional.

4.

Press OK when done.

5.

Select Tools > Message Settings...

6.

Click on “Add Message Number to Subject Line” based on the format
desired.
Turn on Message Number Prefix “P” if desired. This further ensures
message number uniqueness between packet and voice messages.

7.
8.

Press OK when done.

For instance, suppose this option is checked and the Report Settings form is filled
in as follows:
In Santa Clara County, CA, “CUP” is the 3‐character county designation for the City
of Cupertino. The next time a new message is created, Outpost automatically
places a message identifier in the subject line in the following format:
<tactical id>-<next message number>:
So, assuming the above report settings, the following is the result the next time a
message is created:
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At this point, the user can enter additional subject line text following the identifier.
In Santa Clara County, the combination of the Tactical ID and the Message Number
uniquely identifies this message for the County EOC.
The next message created after the above message would have the Message
Identifier of “CUP-289P: ”, and so on (see the next section for the exception).
These options control how Outpost assigns message Identification numbers to a
message.
Control Group
Outbound Message
Identification

Description
When checked, any message that you create will have
a message identifier assigned.
Without hyphenation: the 3 character tactical
Identifier and number are side by side.
With hyphenation: the 3 character tactical Identifier
and number are separated by a single dash character
“‐”. This is useful if your 3 character Tactical Identifer
contains numbers such a “F12” for Fire Station 12.
Data Format: the 3 character tactical Identifier
followed by a 12 digit numeric date/time string in the
format: yymmddhhmmss.
NOTE: If the Tactical ID is left blank on the Report
Settings form, then only the number is entered in the
subject line.
Default: UNCHECKED
____________________________________________
Add Message Number Suffix: Adds a character to the
message ID. The user can select any letter they wish.
Add Message Number Separator: Currently, this is
defined as “: ” (Colon followed by a space). This may
be configurable in a future release.

Inbound Message Identifier
There are some municipalities that require that all messages, both outgoing and
incoming, be identified with a Local Message ID. Outpost can also assign all
incoming messages with a Local Message ID (LMI). Once this option is enabled,
this field and its value will show up as follows:
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1.

Message Listing: The LMI field will be visible as part of the base message
listing for all folders. If not used, the field can be shrunk so that it is not
displayed.

2.

Message Display: If an LMI value is assigned, it will be presented on the
message form.

3.

Read and Delivery receipts: The LMI value will be added to all receipts sent
back to the original sending station.

4.

ICS309 Comm Log: The LMI value is optionally included in the ICS 309
Communications Log report.
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Control Group
Inbound Local
Message
Identification (LMI)

Description
When checked, all informational messages that you
receive will have a message identifier assigned.
Administrative messages (READ, DELIVERED) messages
will not get an LMI assigned.
Assign a Local Message Number…: When checked,
the LMI will be assigned.
Default: UNCHECKED

NOTES
1.

8.4

The LMI value will have a “P” listed after it to indicate it as a Packet Message.
This should help the EOC staff differentiate it from other types of messages
that are coming in.

Settings for Replies and Forwards
The 3rd tab controls how a message behaves when it is selected for Replying or
Forwarding.

The following table summarizes the options available.
Controls
Replies/Forwards
defaults

Description
Set default to Private Message: When this option
is checked and when replying to or forwarding a
message, regardless of the original message type, the
message will be set as a Private message.
Set default to Received Message Type: If this
item is checked and when replying to or forwarding a
message, the message type will be set to be the same
as the original message type.
NOTE: This option excludes NTS messages.
Default: Set to Private
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Controls
Close original
message…

Description
To avoid desktop clutter, checking this box will close
the original message after selecting it for replying or
forwarding. If you want to leave the original message
open while completing a reply or forward message,
uncheck this box.
Default: CHECKED: close message on reply or forward.

8.5

Receipts
The 4th tab controls how Outpost handles global message receipt requests.

The following summarizes the options available.
Controls
Always request a
Delivery Receipt.

Description
This option is set by the originating station.

Always request a
Read Receipt.

This option is set by the originating station.

Auto-Delivery
Receipt

April 9, 2020

When this setting is checked, all messages will be sent
with a Delivery Receipt request set. This option can be
overridden for individual messages at the time the
message is being created.
When this setting is checked, all messages will be sent
with a Read Receipt request set. This option can be
overridden for individual messages at the time the
message is being created.
This option is set by the receiving station.
This option sends a Delivery Receipt for Private and
NTS messages back to the originating station,
REGARDLESS of whether a Delivery Receipt was
requested by the originating station. Bulletins are
skipped.
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Controls
Auto-Read Receipt

Description
This option is set by the receiving station.
This option sends a Read Receipt for Private and NTS
messages back to the originating station, REGARDLESS
of whether a Read Receipt was requested by the
originating station. Bulletins are skipped.

8.6

Settings for Deleting Messages
The 5th tab controls how outpost handles deleting messages.

The following summarizes the options available.
Controls
Deleting
Messages

Description
In general, deleting a message from any folder (other
than the Deleted Mgs folder) will cause the selected
message to be moved to Deleted Mgs folder.
However, deleting a message from the Deleted Msg
Folder permanently deletes the message from
Outpost. This option determines whether the user is
prompted to confirm that they really want to
permanently delete the message.
Default: CHECKED; prompt before final delete

8.7

Advanced Settings
PacFORMS is a system of browser‐based HTML forms that provide a user‐friendly
way to enter specific information ultimately to be transmitted by Packet radio.
Field labels and blank fields are not part of the transmitted record. Instead, data is
extracted from each field and tagged with a field reference. Similarly, Ics213
Messaging is a different message capture form that also sits outside of, and
interacts with Outpost. Both rely on the Opdirect Message Capture System, a
program for receiving messages from these 2 sources.
See: http://www.scc-ares-races.org/pfpublic/pacforms.html for details.
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The 6th tab controls how Outpost handles these external message sources.

Figure 8: Advanced Tab
Controls
Automatically
enable Opdirect

Description
The Opdirect.exe program is delivered with Outpost
and listens for and processes incoming message from
PacFORMS, Ics213mm.exe, and other add‐on
programs. If you intend to use any of these, you MUST
turn on Opdirect.exe.
Once checked, restart Outpost to run this program.
If the Opdirect.exe program is missing from the
Outpost directory, this option is not enabled.
Default: UNCHECKED

If the Message is
newly submitted

This control determined is PacFORMS is opened in its
native program when first received by Outpost.

If the Message
was previously
submitted

This control determined is PacFORMS is reopened in
its native program any time after it was initially
received and the message updated.

Open a received
PacFORMS…

This option causes received PacFORM messages to be
opened in their native form.
Default: Never open in its native program
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9 Using the Address Book
9.1

Introduction
The Address Book is integrated with Outpost and provides the following features:
Multiple address formats
The AX.25 packet world has evolved into a mix of different address types that
Outpost can support. These are:
Call Sign

KN6PE

The most common addressing scheme used. This
works with all BBS/PBBSs out there.
Tactical Calls

CUPEOC

Tactical Calls are supported by Outpost and make an
assignment operator‐neutral.
Hierarchical Address

KN6PE @K6KP
KN6PE @K6KP.CA.USA.NOAM
KN6PE @K6KP.#NCA,CA.USA.NOAM

The different variations of these address types
depends on the destinations and the capabilities of
BBS in use (such as using White Pages).
NTS

95014 @NTSCA

This is a variation of the Hierarchical addressing
scheme, and is treated differently on a BBS.
SMTP

kn6pe @arrl.net
SMTP:kn6pe@ arrl.net

The xNOS and Winlink BBS families support standard
smtp address with only a minor difference with
declaring the address in the TO: field.
Address Book entries
When you create an address book with a single address, you are essentially
creating an Alias. You can define a friendly name (such as JIMOB) and associate it
with a single address for those hard‐to‐remember call signs or email addresses
(such as KN6PE or kn6pe @arrl.net).
Multiple addresses can also be entered under a single friendly name to create a
Distribution List (DL).
Other information can be associated with the entry as well, such as phone
numbers, agency names, and general free‐form text fields.
When creating a message with an Address Book entry, the addresses associated
with the DL is entered into the TO: field as usual, with the “+” sign in front of alias
name (+JIMOB or +SCC_RACES). The “+” sign tells Outpost that this is an address
book entry, and not a directly entered address.
Forwarding Address Book Entries
You can share your address book entries by forwarding them to other Outpost
users. These packet messages will be the bare minimum made up of the entered
data that can be loaded into the recipient’s address book at his/her discretion.
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Mixed‐use To: lines
Initially, any Winlink or JNOS user who populated a bunch of addresses onto the
TO: field was managing the distribution list in their head. Now, Outpost users can
enter addresses, single user address book entries, DLs, or in any combination.
Address Book substitution at message send time
Once an Outpost message is being processed for sending, Outpost checks the To:
line for any address book entry, and expands it into its defined address(es).
Winlink naturally handles lists of addresses, so Outpost will do nothing more than
expand any address book entries into their defined addresses, and then sent the
message as is. Winlink will manage distributing the message as it does today.
For JNOS, if Outpost detects multiple addresses on the To: line, when performing a
Send, it changes the SP (Send Private) command with the SC (Send Copies)
command, and formats the message so that a single message is send to multiple
addressees. Like Winlink, JNOS then manages distributing the message as it does
today.
Other than Winlink and JNOS, there is no other known BBS that supports handling
a list of addresses within one message. When Outpost encounters a DL for a non‐
WL2K/JNOS BBS, it will expand the distribution list and create one packet message
for each distribution list entry. So, a DL with 5 entries will result in 5 messages
being sent, one to each recipient.
Duplicate address checking at message send time
With the advent of DLs and the ability to add multiple destinations on a message,
the risk of creating duplicate messages goes up. While not really an issue on the
internet side, this is a problem for RF‐sent messages since many environments are
still operating at 1200 baud and duplicate messages needlessly consume
bandwidth. Regardless of the BBS, all To: lines will be checked for duplicate
entries. If duplicates are found, then they are removed.
Address type checking at message send time
One of the Outpost features is its ability to “discover” the type of BBS being used
at the time you initiate a Send/Receive Session. Because not all BBSs support all
address formats, Outpost will check the To: line and each address format against
the BBS to ensure that no inappropriate address formats are sent. Address type
checking is performed against this table:
BBS/PBBS Types
All Kantronics
All MFJ
All AEA/Time Wave
AA4RE
BPQMailChat
DXNET
F6FBB
HAMSERV
JNOS, TNOS, SNOS
MSYS
N0ARY
NNA
OpenBCM
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BBS/PBBS Types

Call Sign



RLI
WL2K (RMS, CMS)

9.2

Address Types
Hierarchical/NTS


SMTP


Address Entry
This section describes how an address book entry is set up.
The form for making and reviewing Address Book entries is accessed from the main
Outpost menu Setup > Address Book…
The form is made up of 2 Tabs across the top. These tabs are:
Tabs
Address Entry

Description
This tab contains that critical definition items for an
address entry.

Contact
information

Additional (and optional) information can also be
entered to further define an entry.

The following sections describe these tabs in detail. The 1st Tab is the Address
Entry Tab.

This tab has the following fields:
Fields
Find a Name

Description
A Pull‐down menu of the address entries previously
entered in Outpost.
After pressing the New button, this field is hidden and
not used.
Default: the first address entry listed.
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Fields
Details

Description
Name: When Finding a Name, this field shows the
name of the address picked by the above pull‐down
menu.
When creating a new entry, this is the field for
entering the friendly name for the new address book
entry. Valid characters are “a” thru “z”. “0” thru “9”a
period (.), and underscore(_).
Org: Optional, this field lets you enter an organization
name for this address entry.
Default: Blank

Packet / email
Addresses

Enter one or more addresses in this field. See the rules
for separating addresses for distribution lists in the
options description above.

Notes

Optional; Enter any free‐form comments or notes for
this particular address.

The following describes the controls that are available.
Controls
New
Copy

Forward

New Message
Delete

OK
Apply

Cancel

Description
Sets up a new address book entry. All fields on the
menu are either cleared or set to their default settings.
Allows the user to copy or Clone the currently
displayed address entry. When pressed, the friendly
name is used along with the words “‐‐COPY_OF”
appended to it to ensure it is a unique name. This
name can then be changed, along with the other fields
for this entry.
Allows the user to forward the currently displayed
address entry as a packet message. This is a good way
to ensure that users within your operating group are
using the correct addresses for common messaging
when Bulletins do not make sense.
Action Menu only, creates a new message addressed
to the entry being displayed.
Allows the user delete the currently displayed address
entry. The user will be prompted whether they really
want to delete the entry.
Same as Apply, but closes the menu on completion if
the field validation is successful.
Causes all required fields to be validated. On
completion, the address entry menu remains open.
The Apply button becomes enabled as soon as any
field is changed by an update to an existing
configuration or by creating a new address book entry.
Cancels any changes that may have been made to the
form, and the form is closed.

The 2nd Tab holds optional contact information on this address entry.

April 9, 2020

78

Outpost Packet Message Manager v3.3 c081
Users Guide – Basics

9.3

Thoughts on address naming standards
Think about how you will use your address book entries. Because Outpost will
confirm that address type (Call sign, hierarchical, smtp) against the BBS type, it will
aggressively try to avoid an address error at send/receive time. HOWEVER, this
may give you a false sense of security that any message you create will ALWAYS
get delivered to the end user regardless of the BBS. THIS IS NOT THE CASE (see
Section 9.1 on Address Type Checking for this discussion).
One suggestion is to create addresses for different BBS Types. For instance:
DL_CARES_AEC
DL_CARES_WL2K
smtp addresses
JIMO_HOME
JIMO_JNOS

A Distribution List used for a local KPC3 PBBS
A Distribution List used for a local RMS node with
A single address entry of my home email
A single address entry to my home JNOS node

Defining such an addressing scheme is purely optional. But if you intend to share
distribution lists, you may want to agree to some address naming standard to keep
the confusion and training factor to a minimum.

9.4

Setting up a new Address Book Entry
Unlike setting up TNCs or BBSs, creating address book entries is strictly optional
and would be used more as a productivity enhancer rather than a requirement.
While you can still enter addresses directly into Outpost’s message form, creating
address book entries helps cut down on typing errors by defining the address once,
and then using it over and over again.
Set up a new Address Entry as follows:
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1.

Select Outpost’s Setup > Address Book…, then press the New button.

2.

Enter a Friendly Name. This is the name that you can use to identify the
entry.
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9.5

For Single entries, it could be the individuals’ name, initials, or some
other description.
For Distribution Lists, it could be an organization or group name.
Whatever you use, I recommend you keep it short and memorable.

3.

Enter the Address(es). Depending on the selected address type, enter one
or more addresses as appropriate. Regardless of the Address Type option
you choose, you must enter at least one address.

4.

Fill in other optional fields.

5.

Press Apply. This will validate that all required fields are filled in correctly,
and leave the form option. Or, press OK to validate and close this form.

Updating an existing Address Entry
Once you have address entries, you can review or update them whenever you
want. Update an entry as follows:

9.6

1.

Select Outpost’s Setup > Address Book…, then use the pull‐down menu to
review the list of addresses.

2.

Click on the name you wish to review or update. That entry will be loaded.

3.

Make whatever changes you want to this entry, then press OK.

Using Address Book entries in messages
Once you have your address entries defined, you can use them in messages. For
Outpost to know you are using an Address Book entry, place a “+” plus sign in front
of the entry. To use an Address Entry as follows:
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1.

From Outpost’s main menu, press New to open a new message.

2.

In the To: Field, enter the address entry. If you are entering multiple
entries, separate them with spaces, commas, or semi‐colons.

3.

As soon as you tab out of the field, Outpost will clean‐up all entries (case
and separators).
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HINT: Double‐clicking on an Address Book Entry will immediately open the Address
Book to that entry. This is a good way to confirm you want this message going
to this list of people, or want to make changes to the list on the fly.
HINT: Avoid dashes “‐“ in names if you want to double‐click on an entry… Windows
does not pick up the entire DL entry as a single word; the underline “_”
character works fine.

9.7

Auto‐picking an Address Book entry
With the message form open, note that the message’s To: field is a selectable

button.
To select existing address book entries,
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1.

Press the To: (A) button will open the address book quick pick form.

2.

Scroll through the list of addresses and double‐click on each entry to be
added (B).

3.

As the address entries are added, they are formatted and listed to the right
of the form (C). Any number of entries can be added.

4.

Press OK when done and the selected message recipients will be appended
to the To: field.
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9.8

Forwarding Address Book entries
While having a DL or other Address Book entry is good for your personal
productivity, having the same lists used by members of your communications team
improves the productivity and efficiency of the entire team. This could be a DL of
your immediate response team, a DL of SMTP addresses you use for Winlink
forwarding, or just a general update on yourself in terms of your contact
information.
Regardless with how you use the Address Book, Outpost lets you share entries
with your team by forwarding it as a packet message.
You can share an Address Entry as follows:
1.

Select Outpost’s Setup > Address Book…

2.

Use the pull‐down menu to find the address you want to forward. Once
you have it, press the Forward button.

3.

Outpost will create a new message with a compact list of the address book
entry fields.

4.

Note the layout of this message:



5.

!ADDR! begins the address book entries
[.]
ends the address book entries

Complete the message as usual:





Fill in the destination To: field
Make any changes to the Subject Line
Set the Message type as Private or Bulletin
Press Send.

NOTE: You can add text Before the !ADDR! tag or after the [.] tag. DO NOT place any
additional text in between these tags!
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9.9

Receiving Address Book entries
On the receiving end, an Address Book message will be retrieved like any other
message. However, it is up to the recipient to determine whether they want to
add it to their local Address Book or not.
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1.

Retrieve your messages as you usually do, and then open the message.

2.

Press the Actions > Add Address menu option to add this address to your
address book. This option is enabled only when an Address Book entry is
received.

3.

If an entry by the same name exists, you will be prompted if you want to
overwrite it.
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10 Customizing the Send/Receive Session
Outpost provides several options for controlling how the Send/Receive Session
executes. The control options are accessed from the Outpost main menu,
Tools > Send/Receive Settings… .These settings are discussed here.

10.1 Automating the Packet Session
Messages can be sent to the BBS whenever the Send/Receive button is pressed on
the main Outpost form.
However, if Outpost is used as part of an ARES/RACES network for moving packet
traffic within an Operational Area, then having the means for automatically
sending outgoing traffic and polling the BBS for incoming traffic on a periodic basis
allows Outpost to operate unattended, thereby making more efficient use of the
emergency responder staff.
Automation: Controls when Send/Receive Sessions will be executed.

Figure 9: Send/Receive Automation Menu
Operation
Manual
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Description
When this option is checked, no automatic initiation of
Send/Receive Sessions occurs. To initiate a session:
▪ Press the Send/Receive button on the Outpost
main form, or
▪ Have Outpost send the message immediately after
a message is created (discussed below).
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Operation
Schedule… every
“X” minutes

Description
Interval Scheduling: Outpost will initiate a
Send/Receive Session every “X” minutes. The timing
for this is determined by the operator, with valid
settings ranging from 1 to 999 minutes.
To use this feature:
▪ Check the “Schedule a send/receive every [ ]
minutes.” box.
▪ Enter the number of minutes between sessions.
▪ Press OK.
▪ The time remaining until the next Send/Receive
Session will be displayed on the status bar,
bottom right, just left of the System Time.
▪ To disable this setting, check the “Manual”
button, then press OK.
See the Automaton Considerations section below for
more information about how to use Send/Receive
Automation.

Schedule… at
“X” minutes past
the hour

Slot Time Scheduling: You may want to explicitly
control when a Send/Receive Session runs. This is
handled by using a concept known as “slot times.”
Valid slot times are in the range of 0 to 59, and
correspond to the minutes pass the current hour.
To use this feature:
▪ Check the “Schedule a send/receive at “X”
minutes past the hour.” box.
▪ Enter any number of absolute times in minutes
when you want Outpost to run. The times are the
minutes during an hour when a session will run.
For instance, entries of 2, 17, 32, and 47 mean 2
minutes past the hour, 17 minutes past, etc.
▪ Press OK.
▪ Based on the current PC system time, Outpost will
determine the next time to run a Packet Session,
and the time remaining until that session will be
displayed on the status bar, bottom right, just to
the left of the System Time.
▪ To disable this setting, check the “Manual”
button, then press OK.
See the Automaton Considerations section below for
more information about how to use Send/Receive
Automation.

Send a Message
immediately
when it is
complete.
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This setting causes Outpost to initiate a Send/Receive
Session immediately when the user presses the Send
button on the message form. A full Send/Receive
Session will run.
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Operation

Description
This option does not have any impact on any other
existing Automation timing that may already be
selected. The session timer will continue to count
down to the time of the next Packet Session.

Send/Receive
Button Setup

This option allows the user to customize the Outpost
Send/Receive button. The 3 options are:




Send/Receive: Causes Outpost to always send and
retrieve messages.
Send Only: Causes Outpost to only send messages.
Message retrieval does not occur.
Receive Only: Causes Outpost to only retrieve
messages. Any messages ready to be sent will not
be processed.

Whatever option is selected, the Send/Receive button
will change to reflect the selected action.
Default: Send/Receive
Automation Considerations
In general, automatic message retrieval allows Outpost to be physically located in
the radio room in the vicinity of an amateur radio operator and periodically check
for incoming or out‐going messages. This meets the requirement for having a
control operator present.
The rules around applying automatic message retrieval timing must be worked out
within your Operational Area. For instance, in a configuration with a low
traffic/low station count, setting an interval time of 10 to 15 minutes may work
with little or no collisions. However, this may not be the case with a high traffic
volume or a large number of stations needing access to a single BBS.
For instance, consider an environment of 5 Hospitals needing access to a single
BBS on a single frequency. If the objective is to avoid any transmission collisions
and maximize the times to check for messages, then the 5 Hospitals could be
coordinated and assigned time slots with 3‐minute intervals.

Hospital
Hospital
Hospital
Hospital
Hospital

1
2
3
4
5

Slot 1
0
3
6
9
12

Slot times
Slot 2
Slot 3
15
30
18
33
21
36
24
39
27
42

Slot 4
45
48
51
54
57

Similarly, 8 hospitals could be assigned time slots with 2‐minute intervals:
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Hospital
Hospital
Hospital
Hospital
Hospital
Hospital
Hospital
Hospital

1
2
3
4
5
6
7
8

Slot 1
0
2
4
6
8
10
12
14

Slot times
Slot 2
Slot 3
15
30
17
32
19
34
21
36
23
38
25
40
27
42
29
44

Slot 4
45
47
49
51
53
55
57
59

In the above case, Hospitals 8 and 1 are within 1 minute of each of their slots and
some contention may result.
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Most BBS’s are very robust and can handle multiple connections at the same
time. There is no requirement to avoid concurrent access to a channel by
multiple Outpost users. Channel contention is still handed by the TNC.



When configuring the Outpost environment with time slots, all Outpost
deployment teams should take into account available transmission speeds
(1200 vs. 9600 baud), expectations for packet traffic volume, number of
packet stations on a channel, and the willingness of served agencies to accept
delays due to time‐outs when channel contention occurs. Some
experimenting may be required.



Not all slot times need to be filled in. At least 1 time slot must be configured
for this feature to be used.



There could be situations where some packet stations may generate more
packet traffic then others and need access at least 4 times an hour. Other
stations may need fewer slots. Again, these assignments should be carefully
planned and coordinated to fully optimize the channel.
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10.2 Once a message is received
Receiving: This tab handles what to do once a message is downloaded by the
receiving station.

Operation
Play this sound on
arrival

Description
This option allows you to select a .wav file to be played
when a message is saved in Outpost.
The user can browse for a .wav file, select it, and test it
to confirm that it is suitable for their environment.
See the Play on Arrival Considerations below.

Once Retrieved

The user can set up Outpost to automatically open any
message that contains a listed string of text in either
the From field, Subject field, or Message body.
Default: <blank>

Play on Arrival Considerations
This feature requires that an operational Sound Card is installed on the Outpost PC.
Once you choose a .wav file, pressing the “Test” button will cause the .wav file to
play. If there is a problem with the file or the sound card, a sound card is not
installed or enabled, then your PC will issue a “beep” instead.
Several .wav files are included with the Outpost distribution as examples for how
this feature could be used. For instance,
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Sound38.wav – a very obnoxious alarm. If you use this file with the sound
turned up, you will definitely know when a message arrives.



Sound136.wav – used for Notifications.



incoming.wav – a spoken notification. The phrase “Attention, incoming packet
message” is spoken.
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Essentially, you can use any .wav file found on your system, or create your own.
The “incoming.wav” file was created using the Microsoft “Sound Recorder”
program that comes standard with Windows.

10.3 Printing
This tab specifies how messages can be printed automatically.

Groups
Print received
messages

Description
Checking this box will cause Outpost to print each new
message received on their arrival. This is useful to
expedite routing incoming messages to the EOC or
Operational Area staff. The number of copies can be
specified.
Default: unchecked, 1 copy

Print sent messages

Checking this box will cause Outpost to print each
message that was successfully sent. The number of
copies can be specified.
Default: unchecked, 1 copy

Auto‐print with
message headers

If the above print options are checked, checking this
box will cause Outpost to print the messages with the
message headers.
Unchecking this box will cause only the message text
to be printed. This may be desirable if you are sending
or receiving report‐formatted messages and do not
want the clutter of the packet message header.
Default: Checked
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Groups

Description

Print DELIVERY and
READ Receipts

If this box is checked and you have automatic printing
turned on, READ and DELIVERY Receipts will be printed
as well.
Default: UNCHECKED

Print Message Considerations
This feature requires a printer to be configured. If no printer is installed, this
feature is disabled.

10.4 Notifications
This tab specifies what situations will cause a pop‐up alert to occur.

Groups
Display
Notifications

Description
Causes a notification window to be displayed in the
event there is a problem during the Send/Receive
Session. The window stays up even after the
Send/Receive Session window closes.
See Notifications Considerations below.
Default: N0, N1, N2, N3 checked

Play this sound on
notification

This option allows you to select a .wav file to be played
when a notification window pops up.
The user can browse for a .wav file, select it, and test it
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Groups

Description
to confirm that it is suitable for their environment.
Default: checked

Notification Considerations
During an unattended Send/Receive session, something may cause an unexpected
BBS disconnect or error condition that may go unnoticed. Outpost will now
generate a pop‐up notification message for the following conditions:








BBS type could not be identified.
Unexpected BBS disconnect while sending messages
Unexpected BBS disconnect while retrieving the list of messages.
Unexpected BBS disconnect while retrieving a BBS message.
Unexpected BBS disconnect while attempting to delete a BBS message.
BBS <name> does not support multiple destinations addressing
Addressing problems such as Address type does not match BBS type.

The notification will be displayed in a pop‐up message window that remains on the
screen even after the Send/Receive Session ends. On receiving a notification, an
alert signal (beep if no sound card is available) will also be sounded. Notifications
can be turned off if necessary.

NOTE: Other conditions may be added as situations of concerns are identified.

10.5 Other settings
The last tab has other general settings you may wish to set.
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Groups
Show Packet
Session Window

Description
When the Send/Receive Session runs, a window pops
up and displays the transactions between Outpost and
the TNC. To hide this window, uncheck this option.
Default: checked
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11 Using Tactical Calls
11.1 Introduction
Many governments define a tactical call sign as “a call sign that identifies a tactical
command or tactical communication facility.”
Amateur Radio operators use Tactical Calls to identify an assignment with which
message traffic is exchanged. Because several different operators may rotate
through that assignment over time, a Tactical Call makes the assignment "operator
neutral," thereby allowing the operators to change without having the assignment
name change.
Some examples of tactical calls are:
A fire station in the City of Cupertino
 Cupertino Fire
A resource staging area at an event
 Staging 1
 County EOC
The county’s Emergency Operations Center
Amateur Radio voice nets have used tactical call signs for years. However, the
flexibility of tactical calls has been elusive in the packet radio world due to a variety
of limitations and constraints. Ideally, tactical call support for packet should be
implemented at the BBS. However, all out‐of‐the‐box BBSs do not explicitly
support the use of Tactical Calls.
As a result, Outpost implements Tactical Calls that is usable on most all types of
BBSs.

11.2 How it works
Outpost's implementation of tactical calls is based on substituting a tactical call
designator in place of the standard Call Sign for message creation (From:), TNC
initialization (my <call>), and BBS activities (List Mine). Almost all BBSs do not
inherently support tactical calls. However, experimentation has shown that a
tactical call can be structured to satisfy the log‐on and call‐sign checking of a BBS,
and can achieve the intent of what Tactical Calls can offer.
While the Outpost implementation is not totally fool‐proof and does have some
limitations, Outpost does give packet users the look and feel of tactical calls while
operating within the rules of (at least) the U.S. Federal Communications
Commission (FCC).

11.3 Is it legal?
Stations that use a tactical call must also identify with their legally assigned call
sign. In the United States, the FCC addresses the subject of station identification in
Part 97.119, and states that each amateur station “… must transmit its assigned
call sign on its transmitting channel at the end of each communication, and at least
every 10 minutes during a communication, for the purpose of clearly making the
source of the transmissions from the station known to those receiving the
transmission. No station may transmit unidentified communications or signals, or
transmit as the station call sign, any call sign not authorized to the station.”

NOTE: AX.25 is the underlying protocol that makes packet work. The AX.25 Link‐Layer
Protocol Specification complies with the X.25 specification with the exception of:
1.
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2.

the addition of an Unnumbered Information (UI) Frame.

The extended address field of every frame is encoded with the station of origin and
destination amateur call signs. In short, under typical use, every time an AX.25
packet is transmitted, it essentially identifies the transmitting station and satisfies
the requirements of Federal Communications Commission (FCC) Part 97.119. For
more information, see: AX.25 Amateur Packet‐Radio Link‐Layer Protocol document
found at http://www.tapr.org/pub_ax25.html.
There are three points to reiterate:


Under FCC rules, station identification must occur at the end of each
communication, and at least every 10 minutes during a communication.



The FCC rules do not state that the expanded AX.25 address field with
embedded Call Sign is required for packet station identification. While the
AX.25 implementation satisfies the requirement, this is not the only method
that the requirement could be met.



Outpost satisfies the requirement for legal station identification by
transmitting the user's valid station call sign at the end of each Send/Receive
session.

11.4 Picking tactical calls
You will have to experiment with your BBS to see to what extent it supports a
tactical call. The following information is based on tests with 2 typical BBSs. Your
results may vary.
KPC3 PBBS
This PBBS is very flexible and can allow almost any type of Tactical Call structure.
The tactical call must be no more than 6 characters long.
The following are examples of usable tactical calls:
CUPFD
A fire station in the City of Cupertino
STAGE1

A resource staging area supporting a fire line

CUPEOC

Emergency Operations Center at the City of Cupertino

F6FBB BBS
This BBS performs limited call sign validation when you first connect to the BBS.
Testing indicates that the call sign needs to include at least one number to be
confirmed as a valid call sign.
As an example, in Santa Clara County, the County Hospital system implemented a
packet network for its 11 regional hospitals using the F6FBB BBS as its packet mail
drop. These hospitals were assigned a tactical call with the structure of <#xxxxx >.
For instance:
1MVECH
Mountain View El Camino Hospital
1PASMC
Palo Alto Stanford Medical Center
1SJVMC
San Jose Valley Medical Center
1SJGSH
San Jose Good Samaritan Hospital
The basic tactical call format that was used above is:
1 CC HHH
\ \ \___3 letter abbreviation for the hospital name
\ \_____2 letters for the city in which the hospital is located
\______the number "1"; arbitrary, satisfies F6FBB’s need to see a digit
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As a check of the above, when a user manually sets up his TNC with the command
my 1MVECH (sets the TNCs call sign), on connecting to the F6FBB BBS, the BBS
does not complain and asks the 1MVECH user to register. In short, the “#xxxxx”
structure satisfies the F6FBB call sign checking logic.

11.5 Setting up tactical calls
To set up a tactical call, do the following:

Manual Confirmation
1.

Pick a tactical call structure based on your BBS TYPE. See the description
above on how to experiment with tactical calls.

2.

Run Ipserial.exe or some other terminal emulator.

3.

Set your TNC to the Tactical Call with the mycall command.

4.

Issue the BBS connect command.

5.

Verify the BBS does not generate an error. If so, you may need to pick a
different Tactical Call format. If it prompts you to register, register this logon.

Outpost Setup
6.

Select Setup > Identification...

7.

Check the Tactical Call box

8.

Use the Tactical Call Sign Dropdown box to see if your tactical call is already
created.

9.

If it is not found, press the New button to the right of Tactical Call Sign

10. Enter your Tactical Call Sign
11. Enter an optional ID text.
12. Enter a Tactical Message ID Prefix.
13. Press OK when done.
14. Send/Receive to confirm to can connect without problems.
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